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2 NMS-Edit/Plus for Windows 

Introduction 
Overview 

This document describes the function and use of the NMS-Edit/Plus system, 
developed by Innovative Technology Inc. of Ottawa, Ontario. 

The NMS-Edit/Plus editor allows the user to easily manipulate construction 
specifications.  It works with the NMS/DDN Construction Specification 
database, produced by the NMS Secretariat and Construction Specifications 
Canada.  This database, a standard for the construction industry in Canada, 
provides specification writers and other professionals involved in the industry 
with a comprehensive and easy-to-use source of information. 

NMS-Edit/Plus may also be used with other master specifications (such as 
CONSPEC or DEVIS SOMMAIRE TYPE), or with user entered specifications.  
Because NMS-Edit/Plus understands the specification writing task, it is far 
superior to general-purpose word-processors for this job.  

Contents 
The NMS-Edit/Plus package consists of two major parts:  

(a) A word processing system for editing construction specifications.  NMS-
Edit/Plus performs normal word processing tasks as well as special 
functions such as renumbering and automatic formatting.  The unique 
formatting capability maintains the standard headings and columns of the 
specifications, both in the editor and while the document is printed.  A 
document can be processed in its original two-column format, or in the CSC 
Page Format (sometimes called wide page format). 

(b) The complete NMS/DDN database itself, provided as files on diskette for 
ease of use.  The NMS files are normally installed onto the system's hard 
drive. 

Requirements 

The NMS-Edit/Plus system requires the use of Microsoft Windows version 3.1, 
95, 98 or NT.  It occupies approximately 7 megabytes of space on your hard 
disk.  The portions of the NMS database you choose to install will occupy up to 
8 megabytes of additional space  
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Installing NMS-Edit/Plus 
The NMS-Edit/Plus installer is an easy-to-use program for setting up your spec-
writing system.  You can use it to: 

• Install NMS-Edit/Plus and the NMS database 
• Upgrade your software to the latest version of NMS-Edit/Plus 
• Upgrade your existing NMS-Edit for DOS installation to NMS-

Edit/Plus for Windows 

If you load the NMS data onto your hard disk with the NMS-Edit/Plus 
installation program, each division or group of divisions will be loaded into a 
different directory.  For example: 

• \NMS\E01 - contains English division 1 
• \NMS\E02 - contains English division 2  
• \NMS\F15 - contains French division 15 

Preparing to Install 

The NMS is distributed typically on CD-ROM.  However, a diskette version is 
available.  The NMS may be loaded onto your hard disk for ease of use. 

Diskette users should make a duplicate ‘back-up’ copy of the diskettes before 
use.  When the backup is complete, use the duplicate copy, not the ITI originals, 
for your day-to-day work.  The labels on the NMS diskettes show the applicable 
divisions (i.e. 03-04, 08 etc.).  Some divisions are divided into several binders in 
the hard copy format.  To make co-ordination easier, the NMS diskettes follow a 
similar subdivision.  Division 2, for example, is broken down into 02#1, 02#2, 
02#3, and 02#4, representing the four binders of division 2. 

The diskette label indicates the revision of the NMS.  A revision number 
consists of the last two digits of the year followed by the number of the revision 
in that year, e.g. '9701'. 

Running the Installer 

CD-ROM 

To access the installer on CD-ROM, simply insert the CD and click on ‘National 
Master Specification’ then ‘Install NMS’ from the start-up program.  The 
installer will launch.  Next:  

1. Type the NMS-Edit/Plus access key exactly as printed inside the CD 
jewel case, paying attention to letter case and distinguishing between 
the number ‘1’ and small letter ‘l’, the letter ‘o’ and the number ‘0’.  

2. Type the drive and directory where you wish to install the software.  
NMS-Edit/Plus is normally installed on the ‘C:\NMS’ directory.  
NMS/DDN packages or divisions you have purchased are 
automatically installed under the NMS-Edit/Plus directory.  Click 
‘Install’. 
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3. Select what components you wish to install.  It is most efficient to 
install both program and data to your hard drive.  (If you wish to use 
the NMS with another word-processor, you must always install the 
NMS to your hard drive.) 

4. When installing for an external word-processor, a menu will appear 
allowing you to select the type of format you wish installed.  NMS-
Edit/Plus format is installed by default. 

5. When the installation is complete, select the program group that is to 
hold the NMS-Edit/Plus icon. 

Diskette 

If you have a diskette copy of NMS-Edit/Plus, start the installer by double-
clicking on the ‘install’ icon on diskette 1, or type ‘a:install’ from the ‘Run’ 
command prompt.  The install program will begin.  Next:  

1. Enter the name of the drive and directory where you wish NMS-
Edit/Plus to be installed.  If you are upgrading from NMS-Edit for 
DOS, enter the name of the directory where you have NMS-Edit 
already installed. 

2. You will normally click on the ‘Full Install’ button.  If you are 
installing only new NMS database sections, you may skip the 
installation of NMS-Edit/Plus by clicking on ‘Custom Install’ and 
selecting the components you wish installed.  The installer will then 
copy the files to your hard disk. 

3. You will next be asked for the name of the program group where you 
want the NMS-Edit/Plus icon to appear.  You can leave it as NMS-
Edit/Plus or you can specify a new group if you wish. 

4. You will then be asked for the next (NMS or DDN) data diskette.  If 
you wish to install the NMS database on your hard disk, insert one of 
the database diskettes at this time and click ‘OK’.  When that diskette 
has been installed, you will be asked for the next diskette.  You may 
install the database diskettes in any order.  Continue until all database 
disks are installed.  When you are finished (or if you do not wish to 
install any database diskettes) click ‘Done’. 

5. Lastly, the README.TXT file is displayed on the screen.  Please take 
the time to read this file.  It contains information that may be 
important to you. 

6. If you later decide to add more of the NMS to your hard disk, run the 
installer again and select ’Custom installation’ and ’Install database 
only’. 
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7. When NMS-Edit/Plus is first started, it will ask for a valid access key 
to permit running the program and reading the NMS sections you have 
purchased.  Type in the access key exactly as printed on the insert 
included with the NMS-Edit/Plus package.  Pay close attention to 
letter case and distinguish between the number ‘1’ and small letter ‘l’, 
the letter ‘o’ and the number ‘0’.  

Installing NMS-Edit/Plus on a Network 
NMS-Edit/Plus is licensed for a single concurrent use only.  If you wish to run 
NMS-Edit/Plus on more than one workstation at the same time you must 
purchase a site license to do so from Innovative Technology Inc.  Running more 
copies than you have a licence for is not legal. 

To install NMS-Edit/Plus for network access you need to: 

1. Install NMS-Edit/Plus on a network accessible drive using the NMS-
Edit installer. 

2. Copy BWCC.DLL from your \WINDOWS\SYSTEM directory to the 
server NMS-Edit directory. 

3. COPY NMSPLUS.RF from your \WINDOWS directory to the server 
NMS-Edit directory. 

4. Make the server NMS directory read-only to the workstations. 

This configuration allows users to run NMS-Edit/Plus from the single copy on 
the server.  They can perform all operations except setting their own 
preferences.  The preferences they get will be the ones defined by the 
NMSPLUS.RF on the server directory. 

If you wish to allow users the ability to set their own preferences, you must copy 
the NMSPLUS.RF file to each user's \WINDOWS directory. 

Converting NMS-Edit MS/DOS Files  
Some users wish to use files from the MS/DOS version of NMS-Edit in the 
Windows version.  Since the file formats are identical, no special conversion is 
required, and the files may be freely exchanged between the DOS and Windows 
versions. 
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The Icon Bar 
NMS-Edit/Plus features a shortcut command menu called the Icon Bar.  The 
Icon Bar contains the most common commands and options you will use. 
Buttons on the Icon Bar are divided into four categories: 

File Manipulation 

 
• Open a file 
• Save the document 
• Print the document 
• Spell-check the document 
• Undo or Redo the last command 

Cut and Paste 

 
• Cut 
• Copy 
• Paste 

Mode Control 

 
• Auto-Format ON/OFF ‘Filled-in’ indicates 
• Insert mode ON/OFF the setting 
• Right justify ON/OFF is ‘on’. 
• Auto-Renumber ON/OFF 
• Column counter 

Text Formatting 

 
• Plain text 
• Bold text 
• Underlined text 

Clean-up Commands 

 
• Renumber the document 
• Delete all Spec Notes from the document 
• Delete all Option brackets and underscores 
• Convert the document to NMS Page Format 
• Convert the document to CSC Page Format 



 

 

This section of the NMS-Edit/Plus manual explains 
• the Format of NMS documents 
• how to Create a Project 
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Using the NMS 
Document Format 

The National Master Specification database installs in the standard two-column 
format, with headings on the left, and text on the right.  This format has often 
been criticised as being too wasteful of paper.  In response to these concerns, the 
CSC Page Format was developed to allow the text to move almost to the left 
margin of the paper, while maintaining the same content and paragraph 
numbering.   

 
Sample NMS Page Format 

 
Sample CSC Page Format 

Files may be converted to the CSC format by following these steps:  

1. Edit the file  
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2. Pull down the ‘Control’ menu and select ‘Execute’, select 
‘PAGEFORM.EXC’ then click on OK 

 - or - 

This will set the editor's defaults to the Pageform values and reformat the 
document. 

Note: The definition of CSC Page Format does not include underlines anywhere 
in the document.  Many users prefer to keep the underlines in their documents.  
For instructions on how to alter the standard CSC Page Format to include 
underlines see page 30. 

Users who wish to use a format similar to, but not quite the same as, either of 
these formats should examine the contents of the ‘PAGEFORM.EXC’ and the 
‘NMSFORM.EXC’ files in the NMS directory.  By changing the parameters and 
commands in these files, many other specification formats may be incorporated 
into NMS-Edit/Plus. 

Quick Start 
Whether your NMS is on the hard disk or on diskettes, the process of creating a 
project from the NMS is essentially the same. 

Create a Project 

First, an area to store the project needs to be created.  In NMS-Edit/Plus, use the 
‘New Project’ command from the Project menu.  If you are using a hard disk, 
use the ‘New Directory’ button to create a new directory.  Give it the project 
name or some abbreviation to distinguish it from other projects that may also be 
on the hard disk.  

For simplicity, it is best to create the project directories in the NMS directory. 

If you are using diskettes, insert a new diskette and label it with the project 
name.  (You may need to format the diskette and you may need to change to that 
drive to have it displayed on the ‘New Project’ dialog). 

Once the location for the project is ready, enter the new project name and click 
on the ‘Make’ button.  You have now created the control file for the project and 
established the new project as the current project. 

2. Click on the CSC Page Format button on the Icon Bar 

To convert a document back from CSC format to NMS format, follow the same 
steps but instead, select ‘NMSFORM.EXC’ or the NMS Page Format button on 
the Icon Bar. 
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Add the Sections 

The next step is to copy any master files you wish to add to the project.  Pull 
down the Project menu again and select ‘Add File’.  Turn to page 82 for more 
information on the Add File command.  When the Add File dialog appears you 
will be in the current project directory. 

This dialog contains two file lists and a directory list.  The top file list is a 
normal list of files.  You use it to find files to add to your project.  As you select 
files to be added, they are recorded in the bottom file list.  This lets you work 
quickly and select a number of files for adding to the project at once. 

Using the directory list, find the directory containing the file you wish to add to 
the project.  If you were adding files from division 2 of the NMS masters, you 
would change to directory C:\NMS\E02.  If the files were on a different drive, 
use the ‘Drives’ list to change disk drives.  If you are unsure about navigating 
through directories using a dialog, refer to your Windows manuals. 

The file list shows a selection of the files in the directory.  By selecting the ‘List 
Files of Type’ list you can have only master files, only document files or some 
other selection of files listed. 

When you have found a file to add to the project, add it to the bottom list by 
highlighting it and clicking the ‘Select’ button, or by double-clicking on the file 
name in the list.  You can then find another file and double-click on it.  You can 
even change to a different directory and choose files from that directory.   

After you have selected all the files you want to add to your project, click the 
Add button.  This will copy the files to your project directory.  The original files 
will be left in place and a new copy will be in the new project. 

Had you accidentally double-clicked on an incorrect file name, you can delete it 
from the list of files to be copied by highlighting the file in the lower list and 
clicking the Remove button.  This does not delete the file; it just removes it from 
the list of files to be copied. 

Any master (.MAS) files that are copied into a project in this way automatically 
become working sections (.DOC). 



 

 

This section of the NMS-Edit/Plus manual takes you through a 
tutorial on NMS-Edit/Plus for Windows.  Work through this tutorial 
before starting any real projects.  It won't take long and you will more 
than make up the time by knowing how to use NMS-Edit/Plus 
efficiently. 
 
The first three sessions teach you the fundamentals of NMS-
Edit/Plus.  After completing these sessions you will be able to begin 
work.  The last session teaches you more about using NMS-Edit/Plus 
and fine-tuning it to your office practice. 
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Tutorial 
Session 1: The Basics 

Starting NMS-Edit/Plus 
To launch NMS-Edit/Plus, double-click on its icon.  After the copyright notice 
and version number appears, a dialog asks whether you wish to open a new or 
existing project, open a section file, or use the menus.  Click on the ‘Open a 
Section File’ button. 

Next, the Open command's dialog box appears.  Find the Samples directory in 
the list and select it by clicking the mouse on it.  Then click on the ‘Open’ 
button.  (You could also have double-clicked on the Samples directory). 

The list of files changes to show the files in that directory.  The one named 
‘SAMPLE.DOC’ is the one we want, so select it (by clicking on it) and click on 
the ‘Open’ button again.  After a second or two the sample section appears in a 
window on the screen. 

Screen Controls 
The section appears in a ‘Maximised’ window.  

On the right is the scroll bar.  Use it now to scroll down through the document.  
The Page Up and Page Down keys as well as the Ctrl-Home and Ctrl-End keys 
can also be used to move through the document. 

Notice that the header (which contains the section title, number, date, page 
number and project information) only appears once in the document. 

The section will be re-paginated properly and the header replicated onto every 
page when the section is printed.  On the screen we only ever see a single header 
at the top of the document. 

 
The upper right corner contains the size icon.  Clicking it will shrink the 
window.  Clicking it again maximises the window size. 
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Deleting Paragraphs 
One of the most common things you do when working from a master 
specification is to delete paragraphs.  Let's see how to do it with NMS-Edit/Plus.  

Scroll down so that paragraph 1.1.2 is in the middle of the screen.  Then move 
the I-Beam cursor over the ‘. 2’ and double-click.  The whole paragraph is now 
marked.  It is shown in white on black so you can see exactly how much text is 
marked. 

 
To delete the paragraph you can either pull down the Edit menu and select Cut, 
or you could press any one of the backspace, delete or Ctrl-X keys.  Notice 
when you do so, the entire paragraph is removed and the rest of the paragraphs 
are renumbered. 

Try it again on 1.1.5.  Double-click on the paragraph number and delete the text.  
Scroll down and delete 1.5.1 in the same way.  Notice this time that the title on 
the left remains in place and the next paragraph is placed opposite it and 
renumbered. 
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Working With Options ‘[ ]’ 
Another common feature of master sections is that they contain ‘options’, which 
are always enclosed in square brackets ( [ ] ). In paragraph 1.4.1 there are a 
number of examples.  In this paragraph the options tell us to choose either 
‘shoring and bracing’, or ‘underpinning’, or both.  To choose both we need do 
nothing else since both are there.  But to choose ‘shoring and bracing’ only we 
would need to delete the two options ‘[and]’ and ‘[underpinning]’.  

Move the mouse pointer over the ‘[and]’ option and double-click on it.  The 
whole option is selected.  Select Cut from the Edit menu or press the backspace, 
delete or Ctrl-X key.  The option is deleted and the paragraph is reformatted.  
Use the same procedure to delete the ‘[underpinning]’ option.  

 
Another example of options is found in 1.2.1.  Scroll to there now.  Double-click 
on the word ‘available’ at the beginning of the option.  Once again the whole 
option is selected and selecting Cut, backspace or delete removes it. 

But this paragraph contains another type of option that looks like ‘[______]’.  
This is an option where there is not a standard value or choice but where you 
need to fill in the blank.  Move the cursor over the option and double-click on it.  
As you have come to expect the whole option is marked. 

Now type ‘01380’.  As soon as you typed the first zero the option disappeared 
and was replaced by the zero.  Then the rest of the numbers were entered in the 
usual manner.  This is another shortcut.  Whenever you have something marked 
in NMS-Edit/Plus, typing a letter replaces it. 

Selecting Options and Paragraphs 
So far you have only used the scroll bars to move around in NMS-Edit/Plus.  
Now pull down the ‘Search’ menu and select the ‘Next Option’ command.  
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It automatically finds the next option and marks it for you.  You can also 
execute this command from the keyboard with the Ctrl-O key.  Try it several 
times, moving through the document and finding the options. 

Sometimes when editing a document you know exactly what paragraph you 
want to go to and you want to get there quickly.  To do this, pull down the 
Search menu again and select ‘Find Paragraph’.  When the dialog pops up 
asking for the paragraph number, type in 2.2.2.  

NMS-Edit/Plus immediately takes you to the paragraph requested.  When you 
are working from a marked up print listing, Find Paragraph is a handy way to 
move about. 

Cleaning Up 
Now that you have seen the most common types of things that you will be doing 
in NMS-Edit/Plus, it's time to learn how to finish off the document.  If you want 
to go through the Sample section making more changes and experimenting with 
the commands you have already learned, do so now. 

When you are ready to finish a document, there are a few special menu 
commands to help you.  The first one cleans up the Spec Notes.  These notes are 
found in master files to aid spec-writers in the use of the master.  But once the 
file is edited, you usually don't want them.  You will normally leave them in 
place while editing, and only remove them at the end. 

But our file is still not ready.  When deleting and filling in the various option 
fields, the square brackets were left around the option fields that you left in. 

To do this pull down the Control menu and select ‘Drop SPEC NOTE’ or click 
on the ‘Drop SPEC NOTE’ button on the Icon Bar.  And voilà... the spec notes 
are all gone.  Browse through the file and you will see that they have all been 
removed and that any that were opposite titles have also been correctly handled. 

Select the ‘Drop Options’ command from the control menu or click on the 
‘DROP OPTIONS’ button on the Icon Bar and all of these remaining options are 
deleted.  That was much quicker than removing each square bracket separately.  
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One other thing that we should do before saving our work is to check the 
spelling. 

If there were errors they will be highlighted, one after another, and you will be 
given a dialog with a list of words you could use to correct the misspelled one.  
To substitute a word from the list, just highlight it and click on ‘Substitute’.  
You may also enter a correction manually, ignore the error, or add the word to 
your dictionary. 

 

The last clean-up task to perform is to renumber the file.  In all of your work so 
far, NMS-Edit/Plus has kept the file properly renumbered.  But there are times 
when it can be out of sequence (explained later). 

Choose the ‘Spell’ command from the Edit menu or click on the ‘SPELL’ button 
on the Icon Bar.  This command will check the spelling of the entire document.  
If there were no errors (there probably weren't unless you made some mistakes), 
the cursor will turn to the hourglass cursor for a few moments and then it will 
return to the arrow or I-beam.  

It is always a good idea to choose the ‘Renumber’ command from the control 
menu or from the Icon Bar before printing the file.  It renumbers the entire 
document. 
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Saving 

To leave NMS-Edit/Plus, select ‘Exit’ from the file menu.  This will close any 
windows you have open and terminate the application. 

In this session we have learned the most common operations in NMS-Edit/Plus 
and we have seen how NMS-Edit/Plus saves us time.  Remember, when editing 
a file, using double-clicks on options and paragraphs to quickly remove the 
unwanted text.  Use double-clicks to replace fill-in option fields. 

When you are finished editing, use the Drop SPEC NOTE, Drop Options and 
Renumber commands from the Control menu before saving your work. 

Carefully review the material you have learned thus far.  When you are 
confident with it go on to the next session. 

When you have cleaned up your work, you can save it by selecting the ‘Save’ 
command from the File menu or from the Icon Bar.  If the sample section was a 
master file, the Save command would automatically ask you to set a new name 
for the file, to prevent it from being accidentally corrupted.  
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Session 2: Moving On 

Review  
In the first session you learned about the most basic and fundamental aspects of 
NMS-Edit/Plus.  These were also the ones that you will use most frequently so 
be sure you know them well.  In this session we will amplify those concepts by 
giving you some more useful tools. 

Typing 
Start NMS-Edit/Plus, ‘Open a Section File’, and edit the ‘SAMPLE.DOC’ file 
again.  Scroll down to paragraph 1.3.1; move your pointer over the period after 
the word ‘laboratory’ and click once.  A blinking vertical line appears between 
the ‘y’ and the period.  If you don't get it in the right place, try again.  Using the 
pointer to place the text cursor sometimes takes a little practice. 

This little line is called the ‘text cursor’.  It indicates the position where any text 
you type will be placed.  Try typing ‘ in another city’.  (Don't type the quotation 
marks, but do type the space at the beginning).  As you typed the text, the letters 
were entered and the paragraph retained its correct format even though some 
words needed to be moved to the next line. 

Now move up and double-click on the word ‘representative’.  The whole word is 
marked.  You may also have noticed that the text cursor has disappeared.  Now 
type ‘several’. 

Of course you expected that.  With an area of text marked, whatever is typed 
will replace the marked text.  But you have also learned that double-clicking on 
a word, highlights that word.  You already knew about double-clicking on 
paragraph numbers and options but now you see one more example. 

You can also mark text by dragging the cursor.  Let's look at how to do this. 

Marking  
Move your pointer to the first letter of the word ‘for’.  Now, while holding down 
the mouse button, move your cursor up or down a couple of lines.  Also try 
moving it sideways, staying within the right column of the section.  As you do, 
you will see the area marked on the screen.  When the button is released the 
marked area is locked.  If you want to change the marked area, just start again - 
position the cursor, push and hold the mouse button and move the mouse. 

When you are marking an area in this way, NMS-Edit/Plus looks at the start and 
end point of the block to decide how to mark it.  If you start and end on the same 
side of the document, only that side is marked.  If you start and end on different 
sides, all the text is marked. 

Scroll down to 1.5.1 to see this.  Mark off just the words ‘Shoring and bracing’.  
Now start again with the word ‘shoring’ but this time drag your cursor over to 
the right to include some of the text on the right.  Now move it down a couple of 
lines. 
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Marking text in this way makes editing very easy.  Just mark the text you want 
to replace or remove.  Then either type what you want to replace it with or press 
backspace (or delete or Ctrl-X) to remove it. 

Hint:  To mark large areas of text: use ‘shift-clicking’.  Mark a small area of 
text at the beginning of the block you want to mark.  Scroll down, using the 
scroll bars, to the end of the area you want to mark.  Hold down the shift key on 
the keyboard and click and drag the mouse to mark the end of the block.  This 
extends the previous block to this point. 

Adding New Paragraphs 
Adding new paragraphs is easy with NMS-Edit/Plus.  Just type them in.  
Position the text cursor somewhere on the left side of the blank line between 
1.5.1 and 1.5.2.  We will add a new paragraph on this line.  Once the cursor is on 
the line, use the Tab key to move it to the first indentation.  Although you could 
have placed the cursor by eye, you might easily have put it at the wrong column.  
So you should always use the tab key to position the cursor before typing a 
paragraph. 

Now you are ready to type.  Enter:  
.2 This is a new paragraph that we are putting in 
for learning purposes. 

As you typed you saw that NMS-Edit/Plus made room when it was needed.  All 
we needed to start a new paragraph was enough space to begin typing. 

But what if there isn't enough space? For example how do we add a new sub-
paragraph of the one we just entered?  

With the text cursor on the last line of the paragraph, select the ‘Newline’ 
command from the ‘Edit’ menu" or press ‘F3’.  A new, empty line is inserted.  
Now we can position our cursor (move it to the left then tab to the desired 
indentation level) and begin typing.  Position the cursor at the second 
indentation and type: 

.1 We follow this by another example for your 
edification. 

You may have noticed that there should be blank lines before the new paragraph 
and before the old ‘.2’ paragraph.  In NMS-Edit/Plus you need never worry 
about this.  When the file is printed it will be spaced correctly.  

Opening Multiple Windows 
So far we have only worked in one file, and that may be the way you work much 
of the time.  But NMS-Edit/Plus will allow you to have as many as 50 files open 
for editing at once.  
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If your windows are zoomed, or if you have re-sized them or moved them, you 
may not be able to see an exposed portion of a partially hidden window.  You 
can switch windows by pulling down the ‘Windows’ menu and selecting the one 
you want to view or by pressing ‘Ctrl-F6’. 

Switch to the PRTEST.DOC file now.  Mark the first paragraph by double-
clicking on the ‘.1’.  Pull down the Edit menu and select Copy.  This makes a 
copy of the marked text on the clipboard.  (The clipboard is an area where text 
and pictures can be saved while they are being moved from one place to 
another).  

Switch back to SAMPLE.DOC again and scroll up to 1.3.  Position the text 
cursor on a blank line after paragraph 1.3.1 and use the tab key to position it 
exactly at the first tab position. 

Pull down the Edit menu again and select the ‘Paste’ command.  The paragraph 
that we had on the clipboard is inserted into the document at this point.  This 
technique of marking text, copying it and then pasting it at another point is a 
very useful way to copy paragraphs from one document to another or within the 
same document.  

If you had chosen the ‘Cut’ command instead of the copy command, the text 
would be removed from the original location as it was copied to the clipboard, 
allowing you to move text. 

You can even move text between NMS-Edit/Plus and other word processors 
using the Cut, Copy and Paste commands. 

Using these techniques you can move as much or as little text as you want.  But 
beware! Any underlining or bold facing is lost in the transfer.  You will need to 
replace them later. 

Formatting Text 

 
Pull down the File menu and select Open or click on the Open File button on the 
Icon Bar.  From the file dialog select the file ‘PRTEST.DOC’ and then click on 
the Open button.  This section is now displayed in a new window.  If your 
windows are zoomed in (so that they do not fill the screen), you will be able to 
see both windows.  The new one is down and to the right from the first one.  If 
you move your pointer over any part of a partially covered window, then click 
the mouse, that window is brought to the top of the display so you can work in 
it.  Try changing windows this way now.  

In the paragraph we just pasted, find the phrase ‘NMS and DDN’ and mark it.  
Then pull down the Font menu and select ‘Underline’, or click on the 
‘UNDERLINE’ button on the Icon Bar.  All of the text we selected is now 
underlined. 



 Tutorial:  Session 2 21 

The ‘Plain Text’, ‘Underline’ and ‘Bold’ commands on the Font menu or the 
Icon Bar all work this way: they apply to all of the marked text.  Be careful with 
their use.  A specification is a legal document, not a work of art.  Underlines 
should be used for titles only.  Bold text should be used sparingly, for special 
emphasis only.  Excessive use of bold or underlining defeats their purpose.    

NMS-Edit/Plus always displays the document in ‘Courier New’ font while 
editing.  When printing, it restricts a document to the use of only one font and 
only one size of text for the entire document.  The font menu indicates which 
font is currently in use for printing.  For the present, leave the font selected as 
‘Courier New’ and size ‘11’. 

Getting Help 
This tutorial is a good way to learn NMS-Edit/Plus.  The reference section of the 
manual explains all of the commands available.  But sometimes while you are 
working, you don't want to pull out the manual and leaf through it looking for 
how to do something.  Instead, you can use the on-line help.   

Pull down the Help menu and select the ‘Contents’ command.  This command 
opens the Windows Help Manager and displays the complete list of Help topics 
available. 

You can click on any of the topics to see the related help information. 

Often, in the help information, words appear underlined.  These words are links 
to related topics.  You can click on these words to go quickly to the related 
topic. 

Saving Revisited 
You have seen already how to save your work.  You can save a copy of it as 
well to a new file by using the ‘Save As...’ command on the File menu.  With 
this choice you must always specify a new file name.  

You now know most of the common editing features of NMS-Edit/Plus.  You 
should practice them now to gain more familiarity with them.  When you are 
ready, go on to the next session to learn more about controlling NMS-Edit/Plus 
and to learn about printing. 
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Session 3: Finishing Up 

Using Projects 
In the previous sessions you learned to do most of the editing that needs to be 
done with NMS-Edit/Plus.  In this session you will learn how to start a new 
project in NMS-Edit/Plus.  Then you will find out more about controlling the 
way NMS-Edit/Plus works, and finally you will discover how to print your 
work. 

The best way to control your work in NMS-Edit/Plus is to divide it into projects 
by putting each project into a separate directory.  To begin a new project, the 
first thing we need to is to create a new place for it.  

Creating a New Project 

Start NMS-Edit/Plus now but pick ‘Create a New Project’ from the opening 
dialog.  This brings up a file dialog box.  You should already be in the ‘NMS’ 
directory.  If not, change to the NMS directory by selecting the NMS directory 
from the list. 

Click on the ‘New Directory’ button.  This will ask you for a new directory 
name.  Type ‘Tutorial’ and then hit enter.  This action has created a new 
directory called Tutorial within the ‘NMS’ directory. 

The project name is now ‘Tutorial.PRJ’.  You could change this name if you 
wanted but for now, click on the ‘Make’ button.  You have now created a 
directory and a control file for your new project. 

A new window has opened on your screen as well.  Right now it is empty but in 
the future it will show the names of the sections in the project.  To access any 
commands on the project menu, this window must be the top one on the screen. 

Adding Files 

The next step in creating a project is to choose the master files you will be using 
to start this project.  Select the ‘Add File’ command from the ‘Project’ menu. 

Using the Directory Window, select the NMS directory and then select the 
‘Samples’ directory from that list.  Highlight the file ‘SAMPLE.DOC’ and click 
the Select button to include it in the list of selected files at the bottom of the 
dialog.  Next, click the ‘Add’ button to add the files to the project.  A copy of 
‘SAMPLE.DOC’ has now been added to your Tutorial project. 
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Add File Dialog Box 

The title of the section you added to the project is now shown in the project 
window, along with its section number and the number of pages in it.  (The 
number of pages is zero because we haven't calculated it yet.) 

 
A Sample Project Window 

You can open a file in a project just by double-clicking on its name in the 
project window.  Do so now.  
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Searching and Replacing 
You saw earlier how to scroll through a document and how to find your way to a 
particular paragraph with the Find Paragraph command.  There is one more way 
of moving through the file.  Using the Search command it is possible to move 
quickly to the next occurrence of a particular word or phrase.  

Select the Search command from the Search menu now.  A window pops up 
asking what to search for.  Enter ‘area’ and click on the OK button (or hit enter).  
NMS-Edit/Plus finds the first occurrence of this word and marks it for you. 

 
Search Dialog Box 

To search for the next occurrence use the ‘Search Again’ command (Ctrl-A for 
short).  Try it now.  Now try it once again.  There are no more occurrences of 
the word ‘area’ in this file.  

If we wanted to search for something else, we would first need to move our 
cursor to the top of the file.  The Search command always starts searching from 
where our text cursor is located.  Scroll back to the start of the file now and click 
to move the text cursor to the top line of the file. 

Select the ‘Replace’ command from the Search menu.  In the first field of the 
window that popped up enter ‘case’.  In the second box enter ‘situation’.  (Click 
the mouse pointer in the second box to move the text cursor).  Then click on the 
OK button.  NMS-Edit/Plus will replace the word ‘case’ throughout the 
document with the word ‘situation’.  

The Replace command is a good way to make a common change throughout the 
entire document.  However, it has a disadvantage when changes are done 
blindly, and you can't see what is going on behind the scenes. 
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Replace Dialog Box 

Move your text cursor back up to the top of the file and try the Replace 
command again.  This time replace ‘and’ by ‘or’ and this time check the ‘Verify 
before replacing’ box on the dialog.  Now when each replacement is made, you 
are shown the location and asked whether or not to make the replacement. 

 
Verify Replacement Dialog Box 

Clicking on Replace causes the replacement to be made.  Clicking on Skip takes 
you to the next possible replacement.  Clicking on Cancel cancels the rest of the 
replacements.  Try clicking Replace and Skip alternatively. When you have seen 
how they work, click on Cancel. 
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Standards Checking 
The ‘Update Standards’ command is a unique and powerful feature of NMS-
Edit/Plus.  It searches the open section for standard references to ensure that 
they are up-to-date.  When a standard is encountered in your section, Update 
Standards compares it to its list of current standards and then either flags it as 
invalid, corrects its format, or sets it to the latest revision.  

Start the standards checker now by clicking on Update Standards from the 
Search menu.  A dialog appears requesting more information. 

 
Update Standards Dialog Box 

Update Standards performs two functions.  First, it searches for and optionally 
replaces standards in error with correct ones.  Second, it produces a report of its 
findings.  The two parts of the dialog box reflect this. 

When ‘Update all standards’ is selected, the command performs its searching 
and replacing automatically without any user intervention.  Clicking ‘Report 
only’ tells the command to make no changes to the section, just report its 
findings when done.  Finally, ‘Verify all changes’ locates each standard number 
one by one and prompts for the action to take.  Click on this selection now, 
because it is the most interesting one to examine. 

By default, the dialog appears with only ‘Errors’ to be reported in the report file.  
For our test, click on ‘Substitutions’ to see what changes the program has made 
as well.  Then begin checking with ‘OK’. 

Update Standards Results 

The ‘SAMPLE.DOC’ file we are editing is a very simple test for the NMS-
Edit/Plus standards checker.  In fact, there are only two standards in the section.  
Let’s see what the results of our check are. 

Almost immediately a ‘Verify Standard’ popup appears in reply to our request to 
verify all standards. 
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Verify Standards Dialog Box 

Update Standards finds the first standard reference, ‘CSA A82.8-1977’, and 
determines that it is superseded by ‘CSA CAN3-A82.8-M78’.  Note that it 
wishes to correct both the old revision date and the incorrect format of this 
standard.  If you click on ‘Skip’, the standard will be left unchanged.  ‘Cancel’ 
ignores the change and stops standards checking entirely.  For our example, 
click ‘OK’ to accept the change.  The new standard is inserted in the document 
and the search continues. 

A second dialog box appears for the second problem standard, ‘CSA A82.1’.  
Update Standards wants to change it to ‘CAN/CSA-A82.1-M87’.  Accept the 
change by clicking OK. 

Since standards checking for this section is complete, NMS-Edit/Plus displays a 
summary of changes.  Click OK and a new window opens to display the file 
‘STANDARD.ERR’. 

 
Update Standards Report 

The program reports that two standards were found in the section.  Of the two, 
both were outdated and replaced by current versions.  There were no standards 
in error.  (Had you requested that Substitutions were not to be reported in the 
file, the error file would not be displayed at all.  Since no errors were found, 
there would be nothing additional to report beyond the summary message that 
appeared at the end of processing.) 

You may print the error file now if you wish.  Click on File Close to close the 
window.  
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Editing Tables 
Now let's look at another case you'll run into.  Find paragraph 2.1.1 (for speed, 
use the Find command on the Search menu). A table follows this paragraph. 

To begin with, add a new line to the table by putting the text cursor on the line 
beginning ‘9.5 mm’, then selecting the Duplicate command from the Edit menu.  
When working with tables it is often handy to be able to just duplicate a line and 
change a couple of values in it.  

Try changing the ‘9.5’ to ‘9.7’.  The table is suddenly all jumbled up!  That's 
because NMS-Edit/Plus is handling the table as if it was a paragraph and is 
reformatting it as we type.  So we need to find a way around the problem. 

Undo / Redo 

The Undo command is also on the Edit menu.  

Go to the File menu and select ‘Revert to Saved’.  This restores the document 
the way it was the last time we saved it.  Click on the OK button to complete the 
operation. 

Turning Formatting Off 

Try changing the ‘9.5’ to ‘9.7’ again.  This time the change went in properly.  At 
the right end of the line change the ‘57-83’ to ‘70-83’.  Setting ‘Auto Reformat’ 
off allows you to work in tables without destroying them.  (You could also have 
turned Auto Reformat off and on from the Settings dialog.)  You should set 
Auto Reformat on when you resume editing paragraphs.  Do so now. 

Hint:  Another way to turn Auto Reformat off or on is to type Ctrl-F. 

Click the ‘UNDO’ button on the Icon Bar.  It returns your document to its state 
before the last edit. 

Once you have hit Undo it changes and becomes ‘REDO’ so you can make the 
operation again if you change your mind. 

Now click the Auto Reformat button on the Icon Bar so the light beside the ‘F’ 
dims.  This turns Auto Reformat off. 
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Editing a Section Header 
The section header is a special part of the document which has it’s own 
formatting rules and so deserves special attention.  It contains:  

• the Project Title 

• the Section Title 

• the Section Number, typically 5 digits in length, which follows the 
MasterFormat numbering convention  

• a starting Page Number, normally 1 

• the Date when the section was last edited 

If you attempt to edit the header directly, you will encounter similar problems to 
editing tables.  (Auto-reformat must be disabled or the text will scramble.  Insert 
mode should be off or text on the right end of the line may wrap.) 

The preferred method by far is to use the ‘Header’ command under the Edit 
menu.  This dialog allows you to change an individual component of the header 
and not worry about formatting the text: NMS-Edit/Plus will do this for you.  

 
Header Dialog Box 

Try making a change now: set the date to today’s date.  Simply edit the text in 
the box and click ‘OK’.  The new date is set into the header and formatted 
appropriately for the font and page width that you have chosen.  Edit… Header 
does other work as well, behind the scenes, which will be explained later. 

Hint: Use ‘Change Header’ in the project menu to change the project titles and 
dates for all sections of a project.  This is more efficient than changing one 
section at a time. 
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Page Formats 
There are two standard layouts used for construction specifications.  The format 
of the ‘SAMPLE.DOC’ document is called ‘NMS Page Format’.  This layout 
has two columns of text: titles are on the left and paragraphs are on the right.   

Another commonly used format for specifications is called CSC Page Format. 
Construction Specifications Canada designed the format for use in private 
practice specifications.  It has the advantage of using less paper.  However, it is 
more difficult to read. 

The file is automatically converted.  You can see the difference in the formats 
now. 

The conversion process between formats is controlled by a ‘command-file’ that 
can be altered to provide a number of different formats.  Using the ‘Open’ 
command from the file menu, change to the ‘NMS’ directory and select the 
‘PAGEFORM.EXC’ file. 

You can see that this file is just a series of commands to NMS-Edit/Plus.  The 
‘mode’ lines change the specified parameters on the Settings window.  The 
‘separate n’ line is a special command to remove the titles from the left and 
place them on the line above.  The ‘n’ on this line means ‘no underlines’.  If it is 
changed to ‘y’, the format conversion is the same but for the underlining of 
titles, which are now retained. 

Hint:  If you prefer your CSC Page Format to have underlined headers and 
titles, edit the ‘PAGEFORM.EXC’ file in the NMS directory and change the line 
that says ‘SEPARATE N’ to ‘SEPARATE Y’.  The next time you convert a file to 
Page Format, the underlines will remain. 

If you wish to define your own format that is similar to CSC format but has 
different settings you can easily do so.  Modify this file's values and save it with 
a new name.  Then you will have it available for converting files to your format 
any time you wish. 

Formats with file names other than NMSFORM.EXC and PAGEFORM.EXC 
can only be executed by selecting them from the Execute command in the 
Control menu. 

NMS-Edit/Plus allows you to convert your specifications from one format to the 
other automatically.  Click on the ‘CSC Page Format’ button on the Icon Bar.  
Alternatively, pull down the Control menu and select ‘Execute’.  From the list of 
files select ‘PAGEFORM.EXC’ and click on OK. 

To convert the file to NMS format click on the ‘NMS Page Format’ button on 
the Icon Bar.  Or, choose ‘Execute’ again and select the file ‘NMSFORM.EXC’. 
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Preparing to Print 
NMS-Edit/Plus is able to print your specification in a proportional font, such as 
Arial or Times Roman, but while editing you will only see a Courier-type font 
on the screen.  So, before printing, you will need to select the appropriate font 
and size.  

Selecting a Printer Font 

The default font is Courier New at size 11.  If this is your preference, you need 
not change the font at all.  Otherwise, select the ‘Font…’ command from the 
Font menu.  For our sample, pick the Arial font at size 12.  When a new font or 
size is selected, an automatic Reformat takes place.   

You will notice that the right side of each paragraph appears more ragged than 
before, and some lines even extend past the header boundary.  NMS-Edit/Plus is 
now creating line breaks, not by counting the number of characters in the line as 
it would when printing a fixed-spacing font like Courier, but by summing the 
width of each character and breaking when the line is full.  This approach shows 
clearly where the line breaks will occur.  However, it has the drawback of 
making it more difficult to edit the section. 

Hint:  Wait until section editing is almost complete before selecting a printer 
font. 
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Print Preview 

Next, bring up ‘Print Preview’ under the File menu, to see before printing how 
the document will appear.  The four green arrow buttons at the top allow 
selection of a new page to preview: either at the top of the document, back a 
page, forward a page, or at the bottom of the document.  

The magnifying glass allows you to zoom in to the page to see more detail, or 
out to normal scale.  Finally, ‘X’ closes Print Preview mode.  Try zooming in to 
view one of the tables on page 2.  Then close the view. 

 
Print Preview 

The Print Agent 

Before printing the final copy of a section, you will want to ensure that all the 
Spec Notes are removed from the document, and that paragraphs are aligned and 
numbered properly.  NMS-Edit/Plus’s ‘Print Agent’ command, under the File 
menu, will check your document for these common types of errors and help you 
locate them.  It flags each type of error in a dialog and indicates what portion of 
the document is at fault.  When you correct the problems, run Print Agent again 
to verify correctness.   

Print Agent is invoked automatically each time you print a section. 
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Printing a Section 
To print a file from NMS-Edit/Plus you must have a printer available and 
selected on your system.  If you are unsure about this refer to your Windows 
User Manual. 

The ‘Printer Setup’ command on the File menu allows you to choose one of the 
different printers installed on your system, and configure the printer 
appropriately. 

From the printed copy you can see that NMS-Edit/Plus has paginated the file, 
added continuation as needed, corrected the number of blank lines between 
paragraphs, and generally produced a pleasing layout.  As well, the number of 
pages in the section has been updated in the project window. 

Page Breaks 

As you scroll through the Sample section now, you will notice that there are 
grey lines across the screen wherever a page break occurred.  These lines are 
calculated whenever the file is printed and they remain with the document only 
as long as its window is open.   

If you wish to see the page breaks before printing a file, select the Repaginate 
command from the File menu.  This will calculate where the page breaks will 
occur if you were to print the document.  If you decide that you do not like 
where NMS-Edit/Plus has broken the document you can add a special line into 
the file to tell it to break at that point.  

At the point where you want the new page, insert a blank line and at the extreme 
left side of the line type ‘$PAGE’.  This line will not print but it will control 
NMS-Edit/Plus's pagination of the document. 

Any changes you make to the file may change where the page breaks occur but 
they do not change the positions of the grey lines.  Only the Print and 
Repaginate commands do this.  So, if you have made changes and want to verify 
how they affect the pagination, select the Repaginate command. 

 
Once these preliminary steps are done, select the Sample File window, then pick 
the Print command from the File menu, or use the Icon.  You can select on this 
dialog the pages to print and whether the top line should be printed.  NMS-
Edit/Plus will then print the file. 
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Using Project Level Commands 
The project menu contains a number of commands that are very useful when 
working with a full project.  To this point, all of the things we have learned to do 
involve working with one section at a time.  In the project view you will work 
with as many sections as there are in the project. 

If the project window is not visible, bring it to the top now by selecting the 
‘Show Project Window’ command from the Project menu.  This will give you 
access to the project commands. 

Select the ‘Show File Name’ command.  This changes the project window so 
file names are shown instead of section titles.  To return to the section title 
listing, select the ‘Show Title’ command. 

Building a List of Contents 
Now choose the ‘List of Contents’ command.  Click OK to the ‘List of Contents 
- Options’ dialog.  This will add a new file to the project with section number 
00000.  The file will be a list of all the sections in the project, including their 
page numbers.  The sections will be listed in order, by division.  For now, you 
receive the default division titles.  We will describe how to change these when 
we discuss the ‘Define Header’ command. 

 
Sample List of Contents 

Once the Contents section is complete, it is added to the project and opened in a 
new window.  If you wish to do any special editing on the section, you can do so 
now. 
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The List of Contents can be tailored to meet your special needs.  For example, 
non-NMS-Edit/Plus sections can be generated into the List of Contents by using 
the ‘Add External Section’ command.  As well, special text can be automatically 
added to the beginning and end of the contents section by filling in the ‘List of 
Contents - Options’ dialog.  Consult the reference section of this manual under 
Add External Section and List of Contents for more information. 

Changing Headers 
Usually, the headers at the top of each specification section are the same for the 
whole project.  They contain the date and project name as well as section 
specific information.  The ‘Change Header’ command will change the date or 
project name in all the sections at once.  Select Change Header now and you will 
see a dialog box, showing the project name and date for the current project. 

 
Change Header Dialog Box 

Change the project name field from ‘Canadian National Master Construction 
Specification’ to your company name and a project number.  As soon as you 
started typing in the new project name, the selection box at the top was 
automatically checked to indicate the project name is to be changed. 

Change the date to today's date as well. 
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When you are finished, click ‘Change’ to begin changing the files.  A dialog 
appears showing the header from the first section twice.  The top example shows 
the original file header.  The bottom example is the header changed with your 
new corrections.  You should verify at this time that the change is what you 
expected. 

 
Change Header Confirmation Dialog Box 

You have four possible options at this window: 
 

• OK  Make the changes to this file and show the next file for 
approval. 

• Skip  Don’t make the indicated changes to this file but go on 
to display the next file. 

• Stop Asking  Make the change and make the same changes to all 
subsequent files without showing them on the screen. 

• Cancel  Don’t change this file; cancel the command entirely. 

The areas of the header that are changed by the Change Header command are 
pre-defined to work for standard NMS headers.  If you are working with a 
different layout of header you may need to change the definition of where each 
item in the header is located.  You can do that with the ‘Define Header’ 
command.
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Setting a New Header Layout 
Define Header displays a dialog showing the header from the first section.  The 
radio buttons in the centre of the dialog indicate what part of the header is 
shown with a grey background.  Try clicking the four buttons to see the different 
areas on the header. 

 
Define Header Dialog Box 

You can adjust the size of the areas by holding the mouse button down and 
shifting the top left or bottom right corners of the grey box.  Try it now if you 
like.  The areas defined should not be allowed to overlap.  They should be large 
enough to include the entire contents of that field for any file in the project. 

If you want to see how another file looks with these definitions, click on the 
‘Next Section’ button. 

It is important to understand that Define Header simply tells NMS-Edit/Plus the 
location of these fields in the header of each file.  It does not actually change the 
layout of a file header or move the fields in a section. 
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Division Titles 

At the bottom left of this dialog box is a check box called ‘Division Titles’.  
When checked, NMS-Edit/Plus will include division titles in all subsequent 
Lists of Contents it creates.  If it is not checked, only the division numbers will 
show in the List of Contents. 

Click on this item to turn off the division titles, then click it again to turn it on.  
When turned on, a new dialog appears showing the titles that will be used for 
each division.  Since there is not enough room in the dialog for all of them, only 
divisions 00 to 08 are shown.  Click the 09-17 button to see the remaining ones.  
You can change any of these titles to whatever you wish.  The next time you 
make a List of Contents the new wording will be used. 

 
Division Titles Dialog Box 

We don't want to save any of the changes we have been making, so click cancel 
to return to the Define Header window and click cancel again to return to the 
menus. 
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Generating a Cross-Reference 
Most sections in a project specification contain references to other sections.  
Sometimes these are in the ‘Related Work’ part of the section.  At other times 
they are in the body of the text.  In either case it is important that these be 
accurate.  NMS-Edit/Plus can help you ensure this. 

On the project menu, select ‘Cross Reference’.  Each file in the project is 
processed in turn.  When the command has finished, the error-list file 
‘XREF.ERR’ opens automatically. 

This file contains a list of potential problems in your project.  It lists the sections 
that you referred to but did not include in the project.  Unless someone else is 
providing these sections, you should fix these problems.  The report also 
identifies places where section references are not complete.  It is normally 
advisable, especially in trade sections, to have all references go both ways. 

 
Sample Cross Reference Errors 
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A second file ‘XREF.LST’ is also created.  It is viewed using the Open 
command from the File menu.  It gives you a full listing of all the inter-section 
references, listing them in both directions. 

 
Sample Cross Reference Listing 

Printing the Project 
The last thing we want to mention in this session is the ‘Print All’ command.  As 
you might imagine it prints the entire project in order.  It is especially useful 
when you have changed the headers in all the files and need to reprint the entire 
project.  

At this point you have learned all you need to know to begin editing 
specifications with NMS-Edit/Plus.  It would be a good idea to work through a 
couple of projects to become entirely familiar with this system before going on 
to the next session. 
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Session 4: Advanced Topics 
This session of the tutorial deals with some advanced topics in NMS-Edit/Plus.  
It is a good idea to become familiar with the basic information presented thus far 
before working through this portion of the tutorial. 

In this session we will look at starting new documents, changing NMS-
Edit/Plus's defaults, creating new command files and more printer control 
options. 

Creating a New Document 
To start a new document in NMS-Edit/Plus simply use the ‘New’ command 
from the file menu.  This will present you with an empty window in which you 
can begin typing.  When entering a new section be sure to follow the formatting 
rules for the page format you are using.  In CSC Page Format this is usually easy 
but it is slightly more difficult for NMS format.    

In either case remember some simple guidelines. 

(a) The first line of the file is not usually printed but if it is underlined, the 
underlines are printed.  

(b) All of the lines up to the first blank line are considered to be part of the page 
header and are repeated at the top of every page.  This also means that you 
must not have a blank line in the header.  To get around this problem you 
can put a ‘hard-space’ on the line.  A hard space is treated like a non-blank 
character by NMS-Edit/Plus's formatting and printing routines but it appears 
as a blank.  To type a hard space use Ctrl-Shift-spacebar.  On the screen a 
hard space looks like a small box ‘F’.  

(c) All paragraphs must start with a ‘.1’ or a ‘.2’ etc.  This sequence must 
always be entered at a tab stop position.  Therefore always use the tab key 
to position the text cursor.  

(d) In NMS format, a paragraph that is opposite a title must always be opposite 
the first line of the title.  In other words, this alignment is wrong: 
1.1 Related Work 
Specified Elsewhere .1   Section         12345 

 but the following is correct:  
1.1 Related Work  .1   Section         12345 
Specified Elsewhere 



42 NMS-Edit/Plus for Windows 

Using House Masters  
It is possible to make up your own master files.  We strongly recommend that 
you place them in a separate directory for that purpose.  Mixing them up with 
the NMS masters will only bring confusion and problems later.  

To make a master file, create it in the normal fashion.  When you are satisfied 
that it is correct, you can save it with the Save As… command.  Check the 
‘Master’ box on this window before selecting the Save button. 

If the Master option is not visible it must be enabled from the Preferences 
command, which will be described shortly. 

Adding Special Characters  
The NMS uses a number of special characters in its files.  These include the 
degree symbol as well as sub-script and super-script values.  The following chart 
explains how to type these special characters.  

 
• sub-scripted 

digits  
Ctrl plus the digits on the top line of the keyboard. 

• super-scripted 
digits  

Ctrl and the Shift keys with the digits on the top 
line of the keyboard.  (The minus sign may also be 
used). 

• degree symbol  Ctrl-Shift-d. 

• half symbol  Ctrl-Shift-f. 

• quarter symbol  Ctrl-Shift-q. 

• hard space  Ctrl-Shift-spacebar. 

Other special characters such as French accented characters are obtained from 
the keyboard in the usual manner.  (See your Windows User Manual). 

To make it easier for you to enter these and other special characters, there is an 
'Insert Character' command in the Edit menu.  This command presents a dialog 
box showing all the possible extended characters supported by NMS-Edit/Plus.  
Pick the character you want from the matrix and click the Insert button.  
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Hard Space Character 
The hard space character looks like a box on the screen.  When printed it 
looks like a blank.  It can be used to mark a blank line that is not to be 
suppressed by the printing routines, or it can be used as glue to hold two 
words together.  For example, if you type ‘35 mm’, the formatting routines 
might break the two words up onto two separate lines.  But if you use a 
hard space between the words they will always stay together.   

A hard space
looks like this

 

Controlling Document Formatting 
The ‘Settings’ menu in NMS-Edit/Plus controls the way formatting takes place.  
The following description should help you to understand this menu.  

 
Settings Dialog Box 

Auto Reformat  (Ctrl-F) 

Alternatively, click on the ‘F’ button on the Icon Bar 

selects whether text in a paragraph is to be reformatted every time the 
paragraph is changed.  Auto Reformat is normally on but should be set off 
when editing tables.  It can be turned on and off quickly using Ctrl-F. 
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Auto Renumber 

You can change this value quickly by clicking the ‘R’ button on the Icon 
Bar. 

Right Justification 

You can change this value quickly by clicking the ‘J’ button on the Icon 
Bar. 

English Document 
selects the language of the document.  This selection determines what 
dictionary is to be used when checking the spelling and what words are to 
be used for continuation in printing.   

Width 
defines the width that the text is to be formatted to, in inches.  The default 
is 6.60 inches for the default Courier New 11-point font. 
If you change to a proportional printer font like Times Roman, the width 
will decrease to a value approximating the width of paper required to hold 
the same number of characters in the new font.  Changing back to a fixed-
spacing printer font (Courier New) will cause the width to increase.  Don’t 
forget to run the Edit... Header command (simply confirm with OK) after 
changing the document width, to automatically adjust the header width 
proportionally. 
Hint:  If you are using a large text size or a large binding margin and are 
losing text off the right side of the page, reduce the Width value. 

selects whether paragraphs are to renumber when necessary.  This action 
only takes place on cut, delete, backspace and paste commands.  For 
engineers, architects and spec-writers it is nice to have NMS-Edit/Plus 
renumber automatically.  But for word-processing operators who are 
working from a marked-up copy, the Auto Renumber feature can be a 
nuisance.  These people should turn it off before editing.  (See also the 
discussion of Control… Preferences later in this session.) 

selects whether paragraphs are to be right justified when they are 
reformatted.  When you confirm the command with OK, you are warned 
that the settings you have changed affect the way the text is reformatted.  If 
you select ‘Reformat’ at this time, the entire document will be right 
justified.  If you select ‘Continue’, only paragraphs you edit will be right 
justified.  (You can force the reformat later with the Reformat command 
on the Control menu.)  Justified paragraphs look much the same on the 
screen as unjustified ones; however, the justification will be visible the 
next time you print.  
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Controlling Paragraph Formatting 
The three columns of numbers are parameters that affect the various levels of 
paragraph.  Two of the columns affect only numbered paragraphs.  The third 
applies to spec notes and titles as well.  The numbers down the left side indicate 
the successive levels of indentation for each set of parameters.  

Tabs  
specifies in which column each level of indentation is to begin. 

Indent 
specifies how many tab stops second and subsequent lines of a paragraph 
are to be indented.  The default is that first level paragraphs continue one 
stop in from the ‘.1’ and all other levels continue directly under the ‘.1’. 
For example the following paragraph has an indent value of ‘0’ meaning 
that the second line begins under the period. 
.1   This is a paragraph with the second 
line beginning at the same place as the 
first. 
The next paragraph is formatted with an indent level of 1. 
.1   This paragraph is different. It is 
     formatted with an indent level of 1. 

Spacing  
sets out how many blank lines are to be printed before each level of 
paragraph.  Regardless of how many blank lines are in the file, NMS-
Edit/Plus will put the right number in when printing.  Normally there are 
three lines before a title and one before a first indent level paragraph.  But 
if you want spaces between all levels of paragraph you can change their 
spacing to one as well. 
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Setting Global Preferences 
NMS-Edit/Plus can be configured to operate in certain ways for ease of use.  For 
example, NMS-Edit/Plus does not usually allow you to save documents as 
masters.  But you can change that default by using the Preferences selection 
under the Control menu.  Choose this command now.  

 
Preferences Dialog Box 

The following describes each of these settings and how to use them: 

Make Backups 
tells NMS-Edit/Plus to keep the previous edition of a document (if there is 
one) as a backup when it saves the document.  (It has the same file name 
but the extension ‘.BAK’ is added.)  This is a handy safety feature but it 
does use extra disk space. 

Allow Making Masters  
specifies whether you are allowed to create master files in the ‘File… Save 
As…’ command.  Normally, for safety, this is not allowed. 

Open Windows Full Size 
Normally NMS-Edit/Plus opens a section in a full-size window, to fill the 
screen.  This makes it easy for you to look at all the text at once.  If you 
open many files and like to see all the windows together, turn this option 
off. 
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Print Top Line 
determines whether or not the coded top line of the section is printed, by 
default.  You can override this option for an individual file on the print 
menu. 

Fit Text in Window 
changes the font size used to display the text on the screen so the full text 
width appears in the window.  This makes the text more visible when 
editing.  Select the Font Fonts… command to activate.  It has no effect 
when a proportional printer font is selected, and it does not affect the font 
size used for printing. 

Icon Bar 
turns the display of the Icon Bar on and off.  

Default Font 
Default Font Size 

Master files do not have a font or font size marked in them.  So when you 
first add them to a project and edit them, they are assigned the default font 
and size indicated here. 

Colours 
sets colours for the display of regular text, Spec Notes, and Option Fields 
in the document. 

Override 
allows you to override certain settings in the master files.  By default these 
files have Auto Reformat and Auto Renumber set on.  If you are usually 
working from marked up listings you will find the Auto Renumbering 
default a nuisance, for as soon as you add or remove any paragraphs, the 
remaining ones are renumbered and no longer compare to your listing.  
You could set Auto Renumber off every time you edit a document, but that 
is extra work.  So, you can choose to override the option every time you 
edit a file.  As well as specifying that the option is to be overridden, you 
must also select whether it is to override to the ‘on’ or ‘off’ state.  

Binding Margins  
specifies, in inches, the margins that are to be put on the left edge of the 
page to allow for binding.  You can set four different values, two for odd 
and even pages to allow for double sided copying, and two for the top and 
bottom margins of each page. 

Print Formatting 
NMS-Edit/Plus has a very intelligent print capability.  For most specifications, 
simply printing with NMS-Edit/Plus will break the document up into pages in a 
pleasing and easy to read manner.  Paragraphs will only be split across pages if 
two or more lines are on each page; headings will be continued (if appropriate) 
at the top of pages, etc.  The result will be an easy to read, well laid out spec. 
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Sometimes there are special reasons for altering the default specification layout.  
NMS-Edit/Plus provides for these by allowing a set of special commands to be 
inserted into the document at any point to tell it how to format the page.  These 
are entered into the document like normal lines of text.  They must be typed at 
the leftmost column of the page.  They will not be printed in the final output.   

The three most common types of control lines are: 
$PAGE 
$SPACE 
$FOOT 

$PAGE 

If you add a line to the document that begins with $PAGE then a new page will 
be started at that point in the listing.  If the word $PAGE is followed by a 
number, then the break will occur only if less than that number of lines are left. 

For example: 
$PAGE 10 

starts a new page if less than 10 blank lines are left on the current page.  So, for 
example, to ensure that an entire table is kept on one page of the document, 
place the $PAGE on the line before the table, and number the $PAGE to the 
number of lines in the table. 

$SPACE 

If you add a line to the document that begins with $SPACE followed by a 
number, that number of blank lines will be inserted at that point in the 
document.  If you have asked for more blank lines to be printed than are left on 
the page then a new page will be started but no blank lines will be placed at the 
top of the page. 
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For example: 
$SPACE 3 

leaves three blank lines in the document. 

$FOOT 

In most specifications the header at the top of the page contains the project 
name, the date, the page number and the company name.  When you look at a 
document on the screen, all of the lines up to the first blank line will be included 
in the header.  This header will be printed at the top of each page and the pages 
will be numbered appropriately. 

Some companies prefer to have their company name at the bottom of each page 
instead of at the top.  To do this in NMS-Edit/Plus you will need to add two 
lines to the document.  The first one must have $FOOT at column 1.  The next 
line must contain the message to be printed at the bottom of each subsequent 
page of the document.   

For example: 
$FOOT 
  Innovative Technology Inc. 

places our company name at the bottom of each page of the document on all 
subsequent pages. 

If your footer contains the word ‘page’ followed by a number, NMS-Edit/Plus 
will insert the page number at that point in the footer on every page. 

(NMS-Edit/Plus determines where the header ends and the text begins by 
finding the first blank line after the header.  The $FOOT control should never 
appear in the header.  The best place to put it is separated from the header by 
one blank line.  It will then appear on every page but will not be considered part 
of the header.) 

Automating Operations with Command Files  
NMS-Edit/Plus uses command files to automate certain operations.  You can 
make up your own command files either by modifying the ones we provide or 
by creating new ones in NMS-Edit/Plus. 

To create a command file, just create a new file with the ‘File… New’ 
command.  Then type the commands, one per line.  When you are done, save the 
file and check the ‘Control’ box on the Save file dialog. 

The best place to save command files is in the NMS directory.  Then they are 
always available to you regardless of what directory your project is in. 
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The commands that you may include in a command file are: 
 

• Mode Tabstops  Set the tab stops for paragraph positioning. 

• Mode Indent Set the indentation for second and subsequent lines 
of a paragraph. 

• Mode 
Spacelines  

Set the inter-paragraph spacing. 

• Mode 
AutoReformat  

Set automatic formatting on or off. 

• Mode 
AutoRenumber  

Set automatic renumbering on or off. 

• Mode Justify  Set right justification on or off. 

• Mode English  Set the English language to on or off. 

• Mode 
Pagewidth  

Set the width of formatted text in inches. 

• Reformat Reformat the entire document. 

• Renumber  Renumber the entire document. 

• DropSpecs Drop all spec notes from the document. 

• DropOptions Remove all square brackets from the document. 

• Separate [y/n] Separate the titles on the left and put them on a line 
by themselves.  The parameter specifies whether to 
retain the underlines or not. 

• Unseparate  Find all titles on a line by themselves and put them 
beside the following paragraphs. 

• Size Specify the font size to be used. 

• Font  Specify the font name to be used. 

A sample command file that performs the standard cleanup at the end of editing 
a document might be: 

dropspecs 
dropoptions 
mode justify on 
reformat 
renumber 
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Help Menu 
Along with the familiar Windows-style on-line help for NMS-Edit/Plus, you 
will find in the Help menu: 

• the ‘Statistics’ command, with useful information about the section 
being edited; 

• the ‘NMS List of Contents’ command, describing each section and 
package in the current NMS; 

• ‘About NMS-Edit’, containing the current version of the program you 
are running; 

• plus, other useful reference information, as it becomes available. 

 





 

 

This section of the NMS-Edit/Plus manual describes each of the 
menus and their commands individually.  This description contains 
more detail than that in the tutorial, and is provided for the advanced 
rather than the novice user. 
 
Many of the commands also have command key equivalents.  These 
are indicated with the command description.  Wherever possible, the 
Windows standard keys are adhered to. 
 
For those commands that appear in the Icon Bar, we also show the 
icon beside the command name. 
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Menu Reference 
File Menu 

The file menu provides standard access and control of files and printers.  Many 
of these commands operate in the normal Windows fashion. 

New 
The New command opens a new window in order to start a new document.  
Remember to follow the formatting guidelines given in the tutorial.  Before the 
file can be saved it must be given a name; the Save command will request this 
automatically.  

Open 

Click on ‘List Files of Type:’ to view in the ‘File Name:’ window only those 
files that have a particular extension. 

Inporting Sections from Other Programs 

NMS-Edit/Plus has a built-in converter for WordPerfect and MS-Word files.  
For optimal conversion, the files must be structured in NMS format.  Make sure 
paragraphs are numbered properly according to NMS formatting rules.  
Conversion takes place automatically when a file in either of the above two 
formats is opened.     

NMS-Edit imports Word DOC files, previous to Word 97, directly.  RTF (Rich 
Text Format) files from any version of Word may be imported as well.  So, if 
you have a Word 2000 file to convert for use in NMS-Edit, first save it as type 
RTF in Word.  Then open the RTF file in NMS-Edit. 

Word files are converted to wide-page format when opened.  For a government 
job, click on the 2-column NMS format button in the toolbar to convert the 
document immediately after importing.  A SPEC NOTE or REDACTEUR in the 
document which looks like: 

     SPEC NOTE: Paragraph level is uncertain 
is generated by the conversion program.  It means that the indent of the 
paragraph following the SPEC NOTE may be incorrect.  Watch carefully for 
this message and if you find one, compare the indent level of subsequent 
paragraphs to a printed Word master, to verify that the paragraph indents were 
computed properly. 

 
The Open command opens a file, using a standard file dialog box.  This allows 
changing directories or drives as well as selecting a file to edit.  The file is 
loaded into memory and is displayed in a new window.  NMS-Edit/Plus may 
have up to fifty files open at once (if there is enough memory available). 
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When an NMS-Edit file is opened, its previous settings are restored.  Some of 
these may be overridden by setting the Preferences dialog appropriately before 
the file is opened.  As a shortcut, an Open File button is available on the Icon 
Bar.  

Save 

The Save command is only enabled if changes were made to the file. 

If you specified on the Preferences dialog that NMS-Edit/Plus is to make 
backups, the previous version of the file will be left on disk unchanged except 
that the extension will be changed to ‘.BAK’. 

Save As... 
The ‘Save As...’ command is used to save a file and change its name or type.  
This command displays a file save dialog that includes a file type selection on it.  
A normal specification section is saved as a ‘Section’ file.  A command file is 
saved as ‘Control’ type.  If you are allowed to create master files (see the 
Preferences command) you will also be able to select ‘Master’ type files.  

If the file is being saved as a document it will be given the default ‘.DOC’ 
extension.  Master files are give the extension ‘.MAS’.  Control files are given 
the extension ‘.EXC’.  

Hint:  Files of type ‘Control’ are really just ASCII files.  To convert an NMS-
Edit/Plus file to ASCII for use with another program: edit the file, select the 
'Save As…' command, select 'Control' and enter a new file name.  

Files may also be converted for use with WordPerfect, MS-Word or AmiPro.  
Select the File Type appropriately to choose one of these formats.  NMS-
Edit/Plus will append an extension ‘WP’ or ‘RTF’ to the new file.      

If you specified on the Preferences dialog that NMS-Edit/Plus is to make 
backups, the previous version of the file will be left on disk unchanged except 
that the extension ‘.BAK’ will be added to its name.  

Revert to Saved 
Sometimes, while editing a section, you make a mistake that is awkward to fix.  
Often, rather than fixing it, you would like to just start again.  This is easily 
accomplished with the ‘Revert to Saved’ command.  The last saved copy of the 
file is read into memory.  Any changes you made to the document since the last 
save are lost. 

If you have made changes that you are about to lose, you will be prompted to 
confirm the action. 

This command saves the current file to disk.  If the file has not already been 
saved (i.e. it was started with the ‘New’ command), you will be prompted for a 
file name.  If the file is a master section you will also be asked for a file name; 
the file extension will be changed to ‘.DOC’.  For more information see the 
description of the Save As... command. 
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Repaginate 
This command determines where the page breaks would occur if the document 
was printed immediately.  A grey line across the window indicates where each 
page break occurs.  See the Print Preview command to view an image of the 
document, as it would be printed.    

If further changes are made to the file, the page break marks will not adjust 
automatically.  You should Repaginate again after making changes if you want 
to see their effect. 

The Repaginate command also calculates the total number of pages printed so 
you can adjust the number in your header (if you show the total number of pages 
there), i.e. ‘Page 1 of 9’. 

Printer Setup… 
The exact format of this dialog is dependent upon the printer on your system.  
Usually this dialog asks about scaling, paper size, orientation etc.  See your 
printer manual for more details. 

Print Agent 
‘Print Agent’ performs a supervisory function that ensures, before a section is 
printed, that proper cleanup has been done on the document and that the section 
is in proper NMS format.  It flags each type of error and indicates what portion 
of the document is at fault.  When you correct the problems, run Print Agent 
again to verify correctness.     

The error messages currently returned are: 

• You appear to have a blank line in the header 

Solution: remove the blank line, or add a hard space at the start of the 
line. 

• $-commands in the header are ignored 

 Solution: add at least one blank line between the header and a $-
command. 

• $-commands must begin at the left margin 

 Solution: Move the command to the left margin. 

• The paragraph does not appear to start on the same line as the title 

 Solution: Move the paragraph up or down opposite the title. 

• You appear to have a title with no paragraph attached 

 Solution: There must always be a paragraph opposite a title. 

• You have a $FOOT command at the end of the file 

 Solution: Your footer command will only apply to the last page.  
Move it after the header to have it apply to all pages of the section. 
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• You appear to have an incorrect paragraph number 

 Solution: Correct the number to proper NMS numbering. 

• Spec Notes have not been removed from this file 

 Solution: Remove the notes if desired. 

Print Agent is invoked automatically each time you print a section. 

Print  (F9) 

After printing, the page breaks will be visible on the screen in the same manner 
as they are after the Repaginate command. 

Print Preview  (F8) 
‘Print Preview’ views the document to see how page breaks, page continuation, 
and headers and footers will appear on the printed page.  The four green arrow 
buttons at the top select a new page to preview: either at the top of the 
document, back a page, forward a page, or at the bottom of the document.  

The magnifying glass allows you to zoom in to the page to see more detail, or 
out to normal scale.  Finally, ‘X’ closes Print Preview mode. 

 
The Print command first launches the Print Agent (see above) to check for 
coding errors in the section.  Then it presents a dialog requesting the range of 
pages to print, and whether the top line of the file (the line above the header) is 
to be printed.  After completing this dialog, the document in the current window 
is printed.  
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Print Preview 

Close  (Ctrl-F4) 
This command closes the currently selected window.  If changes were made to 
the file, you are asked whether you want to save your work first.  

Exit  (Alt-F4) 
This command causes all windows to be closed and NMS-Edit/Plus to terminate.  
You are given an opportunity to save any documents that were changed since 
they were last saved. 

 

 
As a shortcut, click on the close icon of the current window. 
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Edit Menu 

Undo or Redo  (Ctrl-Z) 

When the arrow points left, it is an Undo button. 

Cut  (Ctrl-X) 
The ‘Cut’ command removes the marked text from the document and saves it to 
the clipboard.  The previous contents of the clipboard are lost.  

Copy  (Ctrl-C) 
The ‘Copy’ command copies the marked text to the clipboard.  The text in the 
document is not altered by this command.  The previous contents of the 
clipboard are lost.  

Paste  (Ctrl-V) 
The text on the clipboard is inserted into the document at the current insertion 
point.  If there is marked text at the time the ‘Paste’ command is issued, it is 
replaced by the text on the clipboard.  The data remains on the clipboard.  Text 
from other applications may usually be pasted into NMS-Edit/Plus.  

Hint:  Be sure your cursor is positioned where you want the text pasted.  If you 
copied text from the right column, paste it on the right.  If you copied from the 
left column, paste it on the left. 

Clear 
The ‘Clear’ command removes the marked text from the document without 
putting it on the clipboard.  If no text is marked, nothing happens. 

Newline  (F3) 
The ‘Newline’ command adds a blank line to the document on the line below the 
cursor.  Lines added this way are used to make room for a new paragraph, a 
table, or text to the document. 

This command lets you take back your last operation.  Once the operation has 
been ‘undone’, the command changes to ‘redo’ to permit you to change your 
mind.  A button on the Icon Bar provides a quick way to use the Undo 
command.   

When right, it functions as Redo. 
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Duplicate  (Ctrl-D) 
‘Duplicate’ makes a duplicate copy of the line under the text cursor.  It is 
especially useful when building tables.  Once the first line is entered, subsequent 
lines are added by simply duplicating the first line and changing it 

Insert 
The ‘Insert’ command provides an easy way to insert special types of formatting 
into the document.  Select Insert then click on:  

Page Break 
to force a page break at the cursor position.  It generates an automatic 
$PAGE command into the text.   

Non-breaking Block 
to ensure the defined block does not break between two pages.  The block 
of text must be highlighted before the Insert Non-breaking Block 
command is issued.  

Space 
to insert a block of blank lines into the printed output, to allow space for a 
figure, etc.  A dialog box appears requesting the number of blank lines to 
print.  (Use the Newline command to add blank lines into the document for 
new text.)  

Table 
to block lines of table text so they will not be formatted into a paragraph.  
The entire table must be highlighted before the Insert Table command is 
issued.  Insert Table also sets up the table columns so they align correctly 
when printed in a proportional font.  See the section ‘Printer Controls’ at 
the end of the manual for more information on $TABLE, $END and 
$COLS.   

Footer 
to insert a footer line of text into the document.  Options are available in 
the dialog to:  

• position the footer so it takes effect for the entire document or from 
the current page on; 

• justify the text to the left, right, or centre of the line; and, 

• bold the footer text.  
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Header 
The ‘Header’ command provides an easy and powerful way to edit the section 
header.  Text entry fields are available in the Header dialog to modify:  

• the Project Title 

• the Section Title 

• the Section Number 

• a starting Page Number, normally 1 

• the last-edit Date 

If you attempt to edit the header directly, you may find that components of the 
header will wrap to the next line.  You may also have to concern yourself with 
the position and length of the lines above and below.  These problems are 
avoided with Edit… Header.  

 
Header Dialog Box 

When the dialog is confirmed with OK (even if no text changes were made to 
the components of the header), Edit… Header positions and formats the text 
appropriately.  It looks to the project ‘Define Header’ definition to determine the 
location of each component.  If the section being edited is not part of a project, 
the command uses a default header layout to determine positioning. 

If requested, lines are drawn above and below the header to extend to the width 
of the document as defined in ‘Control… Settings’.  Take note that if you 
change the document width in Settings you should always run Header, 
confirming with OK, to adjust the header (and footer) lines appropriately.  This 
is not done automatically by the Settings command. 

Again, when editing a section header, always open the section where possible 
from within a project.  It will then inherit the header definition of the project and 
know the where to position the header components. 

Hint: Use ‘Change Header’ in the project menu to change the project titles and 
dates for all sections of a project.  This is more efficient than changing one 
section at a time. 
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Insert Character  (F11) 
This command is used to insert accented language characters, line drawing 
symbols and other special characters into the document.  After selecting the 
command you are shown a matrix of possible characters.  Highlight the 
character you want.  It is now magnified in the box at the right.  Click the Insert 
button to insert the character into your text.  You may also double-click on a 
character to insert it.  

To draw lines or boxes, use the ‘Line Drawing’ command as described later. 

Delete Line  (Ctrl-F3) 
Use ‘Delete Line’ to remove blank or non-blank lines of data from your section, 
without regard to content.  It performs the opposite function to Newline.  Delete 
Line acts in a somewhat ‘brute force’ method, with no regard to paragraph 
formatting or numbering.  Run the ‘Control… Renumber’ command to readjust 
paragraph numbering, after deleting paragraphs, if required.   

Line Drawing 
Simple lines and rectangles can be drawn in a section using ‘Line Drawing’.  
When invoked, the cursor turns into a crosshairs.  Just click and drag into a box 
or line.  Hold down the ‘Ctrl’ key when dragging to create a double-line box.  
Note that the line and corner characters are inserted as text into your document 
and may scramble when a paragraph is formatted.  It is best to insert blank lines 
and spaces to make room for the line or box before creating the graphic.  

Spell  (F5) 

The Spell command will select the dictionary to use based on the language 
setting.  (See the Control… Settings command.)  As soon as you select the Spell 
command, NMS-Edit/Plus begins checking each word in turn.  If there is a 
spelling error, the offending word is highlighted and a dialog of choices appears 
to correct the error. 

The Spell command allows you to check the spelling of an entire section.  (If 
you want to check only a part of the document, use the ‘Spell Area’ command.)  
NMS-Edit/Plus's dictionary is specialised for the construction specification 
industry.  It contains many words that are not accepted English (or French) but 
are common in specifications. 
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A Spelling Error 

The dialog contains a list of words that NMS-Edit/Plus thinks are close to the 
word you intended.  To substitute one of these words for the misspelled word, 
select the word from the list and click on the ‘Substitute’ button.  (You may also 
double-click on the selected word). 

If the word was spelled correctly, you can either add it to the dictionary or 
simply skip over it.  To skip over the word, click on the ‘Skip’ button.  To add 
the word to the dictionary, click the ‘Add to Dict.’ button.  Before the word is 
added to the dictionary, you must indicate whether the word can appear in upper 
or lower case and whether it must appear exactly as shown.  Proper names and 
abbreviations usually must have exact capitalisation and so they must appear ‘as 
shown’.  Normal words can appear in either upper or lower case. 

Sometimes the word is misspelled but the selections in the list are all wrong.  
When this happens, click the ‘Edit word’ button to bring up a dialog which lets 
you edit the word directly. 

The Stop button on the dialog lets you halt the spelling operation at any time. 

Sometimes you make the same spelling mistake over and over again.  If you do 
this you can check the ‘Remember Correction’ box and NMS-Edit/Plus will 
remember the correction you have made.  Whenever it comes across the same 
mistake again it will make the correction automatically without asking you.  
NMS-Edit/Plus remembers up to 20 corrections in this way.  It remembers them 
only for the current NMS-Edit/Plus session. 

There is a button on the Icon Bar to provide quick access to the Spell command. 

Spell Area 
Sometimes you only want to check the spelling of a small part of the document.  
If you've only corrected a couple of paragraphs, you needn't recheck the entire 
document.  Just select the paragraphs in the usual way (double-click the 
paragraph numbers or click and drag or shift-click), then choose the ‘Spell Area’ 
command. 
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This command works exactly like the Spell command except that it only checks 
the spelling of the words in the selected part of the document, rather than the 
entire document.  Please refer to the Spell command description for the details 
of what happens when it detects a spelling mistake. 
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Search Menu 

Find Paragraph  (Shift-F1) 
The Find Paragraph command prompts for a paragraph number.  Any valid 
paragraph number is acceptable.  Examples are:    

1.1.3 
2.2 
3.2.4.5.7 

If the paragraph number cannot be found, a nearby one is found instead.  So if 
you searched for 3.2.4.5.7 and it didn't exist but 3.2.4.5.6 did, NMS-Edit/Plus 
would find 3.2.4.5. 

This command makes it easy to find your way from a listing to the right place in 
the document. 

Next Option  (Ctrl-O) 
The ‘Next Option’ command finds the next option (text contained in square 
brackets: [ ]) in the document, and marks it for deletion or correction.  An option 
can be:    

• a fill-in the-blank field, shown as underlines between square brackets, 
i.e. [______], 

• a multiple-choice selection, represented by a series of two or more text 
strings, each enclosed in brackets, i.e. [Engineer] [Architect], or 

• an optional word or phrase, which could be any text contained in 
square brackets, i.e. [not]. 

This command provides an easy way for a spec-writer to move through a 
document and quickly make his key choices. 

Search  (F4) 
The Search command scans the document for the next occurrence, after the text 
cursor, of a requested string.  Enter the string in the dialog box and click OK 
when ready.  The search process can look for an exact match or it can look for a 
match ignoring differences in capitalisation.  Just select the appropriate choice in 
the dialog box. 

When found, the string is marked for easy reference and editing.  

Search Again  (Ctrl-A) 
This command scans for the next occurrence of the same string as was specified 
in the previous Search command.  
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Replace  (F7) 
The ‘Replace’ command searches, beginning at the text cursor position, for 
every occurrence of a given string.  When each is found, it is replaced with a 
replacement string. 

When the command is issued, a dialog box prompts for the string to search for 
and the string to replace it by.  At the same time you can specify whether the 
search is to find only exact matches or whether the search should include upper 
and lower case instances of the same string. 

If you ask NMS-Edit/Plus to verify the changes, each time a change is to be 
made, you are shown the change and asked for confirmation. You then can 
choose to replace it, skip it or cancel the command altogether. 

 
Verify Replacement Dialog Box 

If you do not choose to verify the changes, they are all made automatically. 

Update Standards  (F6) 
The ‘Update Standards’ command searches the open section for standard 
references, validates the format of each reference, and ensures that the standard 
number is up-to-date.   

The Update Standards command operates by means of a file in your NMS 
directory containing more than 15,000 current standards from 22 agencies.  
When a standard is encountered in the section, Update Standards compares it to 
its list of current standards and then either flags it as invalid, corrects its format, 
or sets it to the latest revision.  When you purchase the update to NMS-Edit/Plus 
each year, you will automatically get the latest standards data file. 
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Starting the standards checker brings up a dialog requesting more information. 

 
Update Standards Dialog Box 

Update Standards performs two functions.  First, it searches for and optionally 
replaces standards in error with correct ones.  Second, it produces a report of its 
findings.  The two parts of the dialog box reflect this. 

When ‘Update all standards’ is selected, the command performs its searching 
and replacing automatically without any user intervention.  Clicking ‘Report 
only’ tells the command to make no changes to the section: just report its 
findings when done.  Finally, ‘Verify all changes’ locates each standard number 
one by one and prompts for the action to take. 

By default, the dialog appears with only ‘Errors’ to be reported in the report file.  
Clicking on ‘Substitutions’ allows us to see as well what changes the program 
has made. 

Update Standards Results 

When ‘Verify all changes’ is selected, as each standard is encountered, a ‘Verify 
Standard’ popup appears. 

 
Verify Standards Dialog Box 

Here, for example, ‘CSA CAN3-A82.8-M78’ supersedes ‘CSA A82.8-1977’.  
Note that the command wishes to correct both the revision date and the incorrect 
format of the old standard.  If you click on ‘Skip’, the standard will be left 
unchanged.  ‘Cancel’ ignores the change and stops standards checking entirely.  
Clicking on ‘OK’ accepts the change; the new standard is inserted in the 
document and the search continues. 
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When complete, NMS-Edit/Plus displays a summary of changes.  Click OK and 
a new window opens to display the file ‘STANDARD.ERR’. 

 
Update Standards Report 

The error file reports standard numbers which it has no record of in its standards 
file.  The example here shows none of these errors.  Since we requested that 
Substitutions be reported, the replacements are shown.  The program reports that 
two standards were found in the section.  Of the two, both were outdated and 
replaced by current versions.  (Had we requested that Substitutions were not to 
be reported in the file, the error file would not be displayed at all.  Since no 
errors were found, there would be nothing additional to report beyond the 
summary message that appeared at the end of processing.) 

Standard Errors 

A standard error is flagged when NMS-Edit/Plus detects (what it thinks is) a 
standard that cannot be found in its standards database.  A standard is flagged in 
error if: 

• it was retired completely, 

• it was superseded by a completely new number, or 

• it is coded incorrectly in the section and cannot be deciphered 

Standards in error should be examined carefully to see what correction should be 
made, if any. 

In many cases, outdated and retired standards should not automatically be 
replaced by current versions, because the products and processes the new 
versions refer to may not be the same as that in the specification.  Great care 
should be taken in updating standard numbers to ensure that the new versions 
address the same issues as the old. 
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Control Menu 

Preferences… 
The ‘Preferences…’ command presents a dialog showing the current NMS-
Edit/Plus defaults.  When you change these settings they will remain in effect 
until changed again - even between NMS-Edit/Plus sessions.  (Preference 
settings are stored in the ‘NMSPLUS.RF’ file in your Windows directory.) 

 
Preferences Dialog Box 

Make Backups 
tells the ‘Save’ or ‘Save As...’ commands to keep the previous version of 
the file as a backup.  This uses additional disk space but provides a helpful 
safety net in case of errors.   
The backup file has an extension of ‘.BAK’. 

Allow Making Masters 
indicates whether the user is allowed to create master files.  If so, the 
‘Master’ file type selector will be available on the ‘Save As…’ file dialog.   
It is a good idea to leave this function disabled in normal practice, so that 
master files are not randomly created, using up extra disk space. 
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Open Windows Full Size 
indicates whether NMS-Edit/Plus will open documents (using either the 
New or Open command) in windows that fill the screen or in windows that 
overlap one another.  This selection does not change the function of the 
‘Maximise’ icon on the window: it just determines the window's starting 
size.  

Print Top Line 
determines whether or not the coded top line of the section should be 
printed.  You can override this option on the print menu.  

Fit Text in Window 
changes the font size used to display the text on the screen so the full text 
width appears in he window.  After selecting ‘Fit text in Window’, close 
any open documents so that the option can take effect (or select the Font 
Fonts… command).  When disabled, the actual font size is used.  It has no 
effect when a proportional printer font is selected, and it does not affect the 
font size used for printing.  

Icon Bar 
turns on and off the display of the Icon Bar. 

Default Font 
Default Font Size 

sets the default attributes for files such as master files which have never 
been edited in NMS-Edit/Plus.  Master files do not have a font or font size 
marked in them.  So when you first add them to a project and edit them, 
they are assigned default font and size values.  

Colours 
sets colours for the display of regular text, Spec Notes, and Option Fields 
in the document.  

Override 
overrides either or both of the Auto Reformat and Auto Renumber settings 
for a document.  Normally these settings are saved with the document and 
restored when it is opened.  If you prefer to always have documents open 
in a particular mode, set these overrides. 
First, check the override box to indicate the setting to be overridden.  Then, 
indicate (on the right) what the setting is to be (i.e. to the ‘on’ or ‘off’ 
position). 
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Binding Margins 
selects how much left, top and bottom margin is to be added to each page 
(odd and even) as it is printed.  The value is specified in inches. 
By setting a larger value for odd pages than for even pages you can 
produce your sections ready for double-sided copying.  Experiment with 
these values until you find the settings you want. 

Settings… 
The ‘Settings’ command controls the way editing is to occur for this document.  
Changing the settings in one document does not affect any other document.  

 
Settings Dialog Box 

Each of the fields is described in the following pages. 

Auto Reformat  (Ctrl-F) 

Normally, when working in paragraphs, Auto Reformat should be selected.  
It should only be turned off when working with tables.  (Edit… Header 
should be used to edit the header elements.)  This setting may be 
overridden by the Preferences command so that it always defaults to one 
state or another. 

specifies that paragraphs are to be reformatted whenever anything is 
removed (backspace, delete, cut, clear) or added (typing or paste 
commands).  This setting also determines whether NMS-Edit/Plus will 
respect the two columns and keep them separate while editing. 
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Auto Renumber 

This setting may be overridden by the Preferences command so that it 
always defaults to one state or another. 

Right Justification 

If this selection is changed, you are asked whether you want to reformat 
the document so that it applies immediately, or if you want to delay that 
operation.  If you continue without reformatting, only those paragraphs 
that are subsequently changed will be reformatted with right justification.  
Justified paragraphs look much the same on the screen as unjustified ones; 
however, the justification will be visible the next time you print. 

English Document 
determines the language of the document.  If English Document is not 
selected, the document is assumed to be in the French language.  The 
document language affects the language used for spelling and the special 
words used in printing (‘Con't’ or ‘Suite’, and ‘End’ or ‘Fin’).    

Width 
changes the width of text, in inches, on the printed page.  The default is 6.6 
inches for NMS format documents and about 6.8 inches for CSC format 
documents.  (This is with the default Courier New 11-point font.)  You can 
set this value to any width you would like.   
If you change to a proportional printer font like Times Roman, the width 
will decrease to a value approximating the width of paper required to hold 
the same number of characters in the new font.  Changing back to a fixed-
spacing printer font (Courier New) will cause the width to increase.  Don’t 
forget to run the Edit... Header command (simply confirm with OK) after 
changing the document width, to automatically adjust the header width 
proportionally. 
Remember that the right margin width is determined by the paper width 
minus the left margin minus the document width.  If the margin width is 1 
inch (set in the Preferences command) and the width set here is 6.6 inches, 
and we are working with 11-point Courier characters then the right margin 
is calculated as follows: 
Right-Margin  = Paper-Width - Left-Margin - Width 
   = 8.5 - 1.0 - 6.6(72-chars x 11-point/120-pts-per-inch) 

indicates whether NMS-Edit/Plus should renumber the document after 
delete, cut and paste operations, or whether it should only renumber when 
the Renumber command is used.  Users who are reading the text on-screen 
will often want this selection enabled.  But users working from marked-up 
listings will find it hard to find their place if the numbers keep changing. 

affects the formatting of text by determining whether extra blanks should 
be inserted into each line, when a paragraph is reformatted, to provide a 
smooth right margin.  Its setting is a matter of personal preference.  
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   = 0.9 inches 
 
If this selection is changed, you are asked whether you want to reformat 
the document so that it applies immediately, or if you want to delay that 
operation.  If you continue without reformatting, only those paragraphs 
that are subsequently changed will be reformatted to this width. 

Tabs, Indent, Spacing  
are each a column of values.  Each value in a column corresponds to a 
different level of indentation of paragraph or to a different type of item.  
The left side of the dialog area shows the meaning of each entry in the 
columns.  

Tabs 
determines the placement of paragraphs in NMS-Edit/Plus.  If you change 
a tab setting the paragraphs at that level will all move in or out.  Normal 
NMS-format tab settings are ‘22 27 32 37 …’.  Page-formatted documents 
are at ‘5 10 15 20 …’. 

Indent 
determines how subsequent lines of a paragraph are formatted.  The first 
line of a paragraph always starts at the tab stop for that level.  The text 
always starts at the next tab in.  If the paragraph is more than one line long, 
the second and subsequent lines start at the tab stop determined by adding 
the indent value to the tab stop number where the paragraph started.  For 
example this is what a paragraph formatted with an indent of 0 would look 
like: 
.1    This is a paragraph with indent level set to 
zero so subsequent lines begin under the period. 
Here is another example, this time with indent set to 1:  
.1   This is a paragraph with indent 
     level set to one so that subsequent 
     lines start indented from the period. 
If this selection is changed, you will be asked whether you want to 
reformat the document so that it applies immediately or if you want to 
delay the operation.  If you continue without reformatting, only those 
paragraphs that are subsequently changed will be reformatted to these 
indent settings. 

Spacing 
determines how many blank lines are to be inserted before each level of 
paragraph when the document is printed.  If you add extra blank lines to 
your document (see the Newline command) or if you remove extra blank 
lines, NMS-Edit/Plus will always correct the document and print the 
number of lines indicated here. 
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If you need to add extra space so that a diagram can be added, use the 
$SPACE command. 
The default settings for NMS format documents is 0 3 1 0 0 0 etc.  For 
CSC format documents the defaults are 0 2 1 0 0 0 etc. 
Changing these values does not affect the document on the screen.  They 
only take effect when it is printed. 

Reformat  (Shift-F6) 
This command causes NMS-Edit/Plus to reformat every paragraph according to 
the rules currently in effect.  Tables that are bracketed by $TABLE / $END 
controls or tables that are separated from paragraphs by a blank line are not 
affected by this command. 

If you change any settings that affect document format you will be asked 
whether you wish to reformat the document immediately. 

Renumber  (Shift-F2) 
This command renumbers the current document.  All levels of paragraph are 
renumbered.  If the document is a trade section and follows the standard 3-part 
format, NMS-Edit/Plus will change the first digit of the numbering only when it 
sees a line that looks like    

PART 2 
or  

PARTIE 2 
This command is usually used at the end of editing to clean up a section before 
printing. 
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Drop SPEC NOTE  (Shift-F9) 

Users can insert Spec Notes in their own master files.  A Spec Note is identified 
by the words ‘SPEC NOTE’ or ‘REDACTEUR’ in capital letters, beginning at 
the first tab stop. 

Drop Options [ ]  (Ctrl-F9) 

The normal process of editing options is to remove the unwanted ones by 
double-clicking them and deleting them with the Backspace or Cut command.  
At the end of the editing session, clean up the remaining brackets with the Drop 
Options command.  

Execute  (Shift-F3) 
NMS-Edit/Plus has the ability to execute special command files.  These 
command files can be used to change formats or provide automated capabilities 
to NMS-Edit/Plus.  .  

When the Execute command is launched you must pick a command file to 
execute from the standard file dialog.  Once selected, NMS-Edit/Plus executes 
each of the commands in the file, in order, until the end of the file. 

The NMS-Edit/Plus editor can be used to edit and correct command files.  When 
saving the file ensure the ‘Control’ File Type is set on the Save File… dialog.  
Control files have the ‘.EXC’ extension by default. 

Two special command files are provided with NMS-Edit: 

The file being edited is automatically converted.  You can see the difference in 
formats immediately. 

This command removes all Spec Notes from the file and cleans up any problems 
in the text as a result of their removal.  This command is normally done at the 
end of editing, before printing the file.   

This command is normally used to clean up at the end of an editing session.  It 
finds all square brackets in the file, removes them and reformats the paragraphs 
containing them.  Any text between the brackets remains in the file.  Any fill-in 
options (which look like [______]) are completely removed. 

‘Pageform.EXC’ converts a section to CSC format. 

‘NMSform.EXC’ converts a section to NMS format. 



76 NMS-Edit/Plus for Windows 

Command Files 
A command file is simply a list of commands to be executed.  Only one 
command is allowed per line.  The commands allowed are as follows:  

Mode Tabstops n1 n2 n3 n4 ... 
sets the paragraph tab stops in the same manner as the Tabs values of the 
Settings dialog.  The numbers following the command are the tab values.  
They must be in ascending order.  The last value entered is propagated into 
all remaining tab stop entries.  

Mode Indent n1 n2 n3 n4 ... 
sets the paragraph indents in the same manner as the Indent values of the 
Settings dialog.  The numbers following the command are the indent 
values.  They must be in ascending order.  The last value entered is 
propagated into all remaining entries. 

Mode Spacelines n1 n2 n3 n4 ... 
sets the inter-paragraph spacing in the same manner as the Spacing values 
of the Settings dialog.  The numbers following the command are the 
spacing values.  They must be in ascending order.  The last value entered is 
propagated into all remaining entries. 

Mode AutoReformat on/off 
sets the Auto Reformat selection on the Settings menu to the indicated 
state (either on or off).  

Mode AutoRenumber on/off 
sets the Auto Renumber selection on the Settings menu to the indicated 
state (either on or off). 

Mode Justify on/off 
sets the Right Justify selection on the Settings menu to the indicated state 
(either on or off). 

Mode English on/off 
sets the English language selection on the Settings menu to the indicated 
state (either on or off). 

Mode Pagewidth n 
sets the Width selection on the Settings menu to the indicated value in 
inches. 

Reformat 
executes the Reformat command exactly as it would be executed from the 
menu.  

Renumber 
executes the Renumber command exactly as it would be executed from the 
menu.  
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DropSpecs 
executes the Drop Spec Notes command exactly as it would be executed 
from the menu.  

DropOptions 
executes the Drop Options [ ] command exactly as it would be executed 
from the menu. 

Separate y/n 
passes through the entire document separating titles from the left side of 
the text and placing them on a line by themselves.  At the same time, it 
decides how to process any underlines.  If the option following the 
command is ‘y’ (or ‘yes’), the titles are left underlined.  If the option 
following the command is ‘n’ (or ‘no’), all underlines are removed.  See 
the PAGEFORM.EXC command file for an example of the use of this 
command.  This special command is not available from a menu.  

UnSeparate 
passes through the file looking for all titles that come before a first level 
‘.1’ paragraph.  It removes the titles and places them to the left of the text.  
See the NMSFORM.EXC command file for an example of the use of this 
command.  This special command is not available from a menu.   

Size n 
sets the size of the font for this file to ‘n’ points.  

Font Name 
selects font ‘name’ to be the font used for this file.  
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Font Menu 

Plain Text  (Ctrl-P) 
Bold  (Ctrl-B) 
Underline  (Ctrl-U) 

These commands all operate in the same way.  They apply the indicated change 
in text style to the character following the text cursor or to the marked block of 
text.  Text may be marked as:  

 

 

or a combination of bold and underlined. 

Fonts… 
The ‘Fonts…’ command is used to select a font for printing.  NMS-Edit/Plus 
requires that the entire specification be written using one type of text font, and 
one text size.  This adheres to good spec-writing practice. 

Although NMS-Edit/Plus is able to print your specification in a proportional 
font, such as Arial or Times Roman, while editing you will only see a Courier-
type font on the screen.  So, before printing, you will need to select the 
appropriate font and size.   

The default font for master sections is Courier New at size 11.  If this is your 
preference, you need not use the Fonts… command at all.  Otherwise, when a 
new font or size is selected, an automatic Reformat takes place.  

You will notice that the right side of each paragraph appears more ragged than 
before, and some lines even extend past the header boundary.  NMS-Edit/Plus is 
now creating line breaks, not by counting the number of characters in the line as 
it would when printing a fixed-spacing font like Courier, but by summing the 
width of each character and breaking when the line is full.  This approach shows 
clearly where the line breaks will occur.  However, it has the drawback of 
making it more difficult to edit the section. 

Hint:  Wait until section editing is almost complete before selecting a printer 
font. 

If you have a Courier font selected and the text size you chose for printing is too 
large to fit on your screen, pick the ‘Fit Text in Window’ selection on the 
Preferences Dialog.  This will decrease the screen font size without affecting the 
printed text size. 

Plain (all attributes removed)  

Bold  

Underlined  
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Hint:  For best results choose only TrueType fonts.  With other fonts, what you 
see on the screen may not be what you get on the printer. 
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Project Menu 
The project menu is used for project related activities.  It is used to build a 
project, launch the editor to modify a section, and perform global changes and 
consistency checks to all sections of the project.  It is not necessary to edit 
sections from within a project but we strongly recommend you do so.  It is 
essential to work from within a project if you plan to make any global layout 
changes to the section headers.  It also simplifies many operations and keeps 
your work better organised. 

New Project 
Use this command to initialise a new project.  The command presents a dialog 
that permits creating a new directory for the project and naming the project.  

 
New Project Dialog Box 

In general you should create a new directory under the NMS directory for each 
project.  Click ‘New Directory’ to create this.  Then, using the Make button, 
create the project control files.  Two files named after the project, with 
extensions ‘.PRJ’ and ‘.RF’, are created.  You should never delete these files. 

When adding a file to a project, NMS-Edit/Plus is able to remove from the file 
uses of the word ‘Engineer’, leaving ‘Consultant’, for non-federal-government 
projects.  Conversely, ‘Consultant’ is removed, leaving ‘Engineer’, for federal 
projects.  One of these actions is set into effect when you select ‘Federal 
Government’ or ‘Not Federal’ on the New Project dialog.  The default 
‘Undecided’ performs no pre-edit on new sections being added to the project.  
Note there is no warning when these edits are performed during Add File.    
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Opening a Project Section 

When the project is created, a project window will be displayed on the screen.  
The project window lists all sections in the project and their page counts (if 
known).  Double-clicking on a section in the list opens that section for editing.  
Or, highlight the section and click the Open button on the Icon Bar.  

Once a project is open, the other commands on the project menu become 
available.  Only one project may be open at a time.  Use the Add File command 
to move sections into the project.  

Open Project 
This command is used to open an existing project.  When the open dialog 
appears, change to the directory containing the project.  If there is more than one 
project in the directory, select the one you want (file with extension ‘.PRJ’).  
Click on the Open button. 

 
When the project opens, a project window will be displayed on the screen.  The 
project window lists all sections in the project and their page counts (if known).  
Double-clicking on a section in the list opens that section for editing. 

Once a project is open, the other commands on the project menu become 
available.  Only one project may be open at a time. 

Close Project 
Close a project with the Close Project command.  If you want to change 
projects, you must close the current project before opening a new one. 

Close Project saves the current information about the project (as shown in the 
project window) to the project control file on disk. 

Latest Update 
‘Latest Update’ creates a special temporary project containing all the sections 
updated in the most recent NMS update applied to your system.  (If you have 
both the English and French NMS updates, you will be asked which one you 
want to look at).  The only command available from the Project menu when this 
‘project’ is open is the ‘Print All’ command.  You can use the Latest Update 
command to either print an entire update or to examine the new sections.   

Show Project Window  (F10) 
Use this command to activate the project window.  The project window then 
becomes the top window and you can access the other commands in the Project 
menu. 
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Add File 
The ‘Add File’ command provides a simple way of copying master files or 
document files from another project into this project.  You must have the new 
project open when you select this command.    

The Add File dialog contains two lists of files.  The top one is the list of files in 
the selected directory.  The bottom one is the list of files selected for adding to 
the project.  To add master files to your project, first find the directory where the 
master files exist using the directory list. 

 
Add File Dialog Box 

Hint:  The NMS master files are organised by division under the NMS directory.  
Division 01 English files are in directory ‘E01’ in the NMS directory. 

Select the files you want to add to your project from the files in the list.  You 
may do this by double-clicking the file name or by marking it (single click) and 
then clicking the ‘Select’ button.  As you select each file it appears in the bottom 
list.  To remove a file from the bottom list, mark it by single clicking it and hit 
the ‘Remove’ button. 

Continue adding files to the select list this way.  You can add files from several 
different directories if you wish.  You can review the list of selected files by 
scrolling through the bottom list. 

When you are done selecting files, click the ‘Add’ button to add all the files in 
the select list to the project.  A copy of each file is added to the current project.  
The old copy of the file remains untouched. 

Some pre-editing may be done to the files as they are copied to the project 
directory, if the project was set to ‘Federal Government’ or ‘Not Federal’ when 
it was first created.  See the New Project command above for more information.   
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Master files copied by Add File are converted into Section files to save disk 
space.  As the files are copied they are added to the list in the project window.  
Double-click on a file in the project window to open it for editing. 

To allow conversion of ProSpec or NMS Specialist projects to NMS-Edit/Plus, 
the ‘Add from List’ button is available.  Highlight the list file (usually called 
'FILE.LST') and click on this button.  All the files in the list are added to this 
project. 

Before adding a WordPerfect or other format file (from which NMS-Edit/Plus 
has a converter) into a project, open and convert the file to NMS-Edit format 
first, making sure the header layout is consistent with the rest of the project.  
When the formatting is correct, use Add File to bring it into the project.  

If you are cloning an entire project you can use the ‘Add All’ button rather than 
selecting each file individually.  
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Add External Section 
Often files need to be associated with the specification that are not NMS-
Edit/Plus sections, such as a fill-in form or AutoCad drawing.  To add such files 
to the project List of Contents, use the ‘Add External Section’ command.   

 
Add External Section Dialog Box 

When launched, the command brings up a dialog that accepts a section number, 
section title, and number of pages.  The section information is then displayed in 
the project window and entered into a subsequent List of Contents. 

Remove File 
This command is used to remove sections from a project.  Highlight the file in 
the project window by clicking on it.  (Don't double-click).  Then select the 
Remove File command.  The section will disappear from the project list. 

Note: This command does not delete the file from your disk.  It just removes it 
from the list of sections comprising this project.  You can return the file to the 
project later with the ‘Add File’ command.   

Show Title / Show File Name 
When a project is created, sections added to the project show in the project 
window as section number and title.  By selecting the ‘Show File Name’ 
command, the paths and filenames of the sections display in place of the titles.  
To return to the normal view, select ‘Show Title’ in the Project menu.  It makes 
no difference to NMS-Edit/Plus which view you are using; select the one that is 
most convenient for you. 

List of Contents 
The ‘List of Contents’ command adds a new section to the project, with number 
00000, containing the numbers and titles of all other sections in the project.  (If 
there already is a Contents section, it will be replaced.)  

The List of Contents can be tailored to meet your special needs.  For example, 
non-NMS-Edit/Plus sections can be generated into the List of Contents by using 
the ‘Add External Section’ command.  As well, special text can be automatically 
added to the beginning and end of the contents section by filling in the ‘List of 
Contents - Options’ dialog. 
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List of Contents Dialog Box 

When checked, the ‘Include Division Titles’ box adds division titles to the 
division numbers in the section.  ‘Underline the Titles’ provides additional 
formatting to the division numbers and titles.  To add a fixed block of text at the 
start and/or end of the List of Contents, put the text into an NMS-formatted file 
using NMS-Edit/Plus and specify the filename in one of the boxes. 

Click on ‘OK’.  The new List of Contents section is automatically opened so 
you can check it. 

 
Sample List of Contents 

If any sections in the project were not printed since they were last changed, 
NMS-Edit/Plus will process them to determine an up-to-date page count. 
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Replace 
The ‘Replace’ command for the project operates in much the same way as it 
does for an individual section.  The major difference is that this Replace 
command performs the replacement on all files in the project, whereas the 
Replace command on the Search menu does the replacement for only one 
section. 

You are asked what to search for and what to replace the search string by.  You 
can also select whether NMS-Edit/Plus is to prompt you for confirmation before 
each change and whether NMS-Edit/Plus should ignore upper and lower case 
differences. 

Change Header 
The header at the top of each page of a section has special connotations in a 
project.  Some areas of the header change from section to section and some are 
constant for the entire project.  NMS-Edit/Plus provides special control for 
headers in a project.  You can change the project name or date for all sections in 
the project in one easy step with the ‘Change Header’ command. 

When the command is selected, it shows the project name and the date, taken 
from the first section of the project, in a dialog box.  Change the contents of 
these areas to what you want to see in your section headers.  As soon as you 
change anything in these fields the corresponding selection box becomes 
checked.  To cancel a change, just un-check the box by clicking on it. 

 
Change Header Dialog Box 

When you have entered the new header (and/or date), click the Change button.  
A new window pops up showing the old and new headers for the first section.  
The top box is the old header, taken from the file.  The bottom box shows the 
header with your new changes applied. 
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Change Header Confirmation Dialog Box 

The buttons across the bottom of the window allow you to select whether the 
section is to be changed as shown (OK), whether it is to be skipped (Skip) or 
whether NMS-Edit/Plus should change this and all subsequent sections without 
asking for your approval (Stop Asking). 

Change Header is used to change the contents of all headers in a project 
uniformly.  It cannot be used to rearrange elements of the header.  If your 
project files have a different header layout from the standard, use the Define 
Header… command first to tell NMS-Edit/Plus what your new layout is. 

Hint:  If you need to change the size of the header by adding or removing lines 
from it, you must first change the header definition.  Use the Define Header… 
command to add or reduce lines in the Project Name area.  Then use the 
Change Header command to change the project name in all sections.  New lines 
will be added to or removed from the header of each file as necessary. 

Define Header… 
The various operations that access information in the header depend on the 
information being in known places in the header.  Commands affected in this 
way are the ‘Change Header’, ‘List of Contents’, ‘Add File’, and ‘Edit… 
Header’ commands.  If your headers have a different layout, you will need to tell 
NMS-Edit/Plus what that layout is.  ‘Define Header…’ provides the way. 
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Define Header Dialog Box 

Define Header displays a dialog showing the header from the first file in the 
project.  The selectors in the centre indicate what part of the header is greyed.  
Clicking these radio buttons changes the grey area.  If you need to change one of 
these definitions, grab the top left or bottom right corner of the area and drag it 
with the mouse.  Ensure that none of the areas overlap. 

You can check your definitions against other sections in the project by selecting 
the Next Section or Previous Section buttons. 

When you are satisfied that your definitions are correct, Click the OK button to 
accept them.  The definitions are now saved with the project. 

Changing the Header Size 

To add one or more lines to the header (to accommodate a longer project name, 
for example) simply click on the header elements and move or expand their size 
appropriately.  Click on OK to confirm the change.  Then use Change Header to 
modify all sections of the project, or edit each section individually and use 
Edit… Header to rearrange the header elements. 

To remove one or more header lines: first change the definition in Define 
Header, then use Change Header to change to the new header text.  Never 
reverse the order of these commands. 

If the Project Name is expanded to four or more lines, Change Header will 
automatically expand the size of each header in the project when you use it to 
enter the new project name text.  Change Header, however, cannot handle some 
changes properly, such as moving the date field to a new location in the header.  
(Change Header will simply write the new date text at the new location and 
leave the old date intact.)  In these unusual cases, run Change Header as you 
normally would, and then edit each section of the project and run the Edit… 
Header command from within it to remove the date from the old location. 

Still other changes like moving the page number must be done manually from 
within each section. 
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Division Titles 

The Define Header command is also used to define Division Titles for the List 
of Contents command. 

The ‘Division Titles’ check box at the bottom of the window indicates whether 
division titles are to be included in the List of Contents beside the division 
numbers.  If you turn this on, you will be shown the list of division titles.  By 
default they are the standard NMS titles. 

 
Division Titles Dialog Box 

You can change them to whatever titles you want and NMS-Edit/Plus will use 
your new titles when building a list of contents for this project. 

NMS-Edit/Plus allows titles for the standard 16 divisions as well as 0 and 17.  
To access the divisions you can't see, click on the 09-17 button. 

If you want to change the French titles (if you're doing a French project), use the 
‘French’ button. 
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Cross Reference 
The Cross Reference command is very useful for finding errors and potential 
problems in your project.  It takes only a few moments to run, and creates two 
files on disk that you may edit with NMS-Edit/Plus. 

The first file opens automatically.  It is called ‘XREF.ERR’ and contains a list of 
potential problems in the project.  The errors it detects are references to sections 
that are not in the project and references that are not bi-directional.  The first list 
always contains serious errors.  The second list contains problems that may need 
to be fixed, at the specification writer's discretion. 

 
Sample Cross Reference Errors  
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The second file is called ‘XREF.LST’.  It contains a full cross-reference of 
sections in your project.  It tells what each sections refers to, and from where 
each section is referred. 

 
Sample Cross Reference Listing 

Update Standards 
‘Update Standards’ from the project menu operates in much the same way as it 
does for an individual section: it puts up the same prompt window as in the 
editor, but processes all files in the project when confirmed with OK.  When 
complete it conveniently displays a report of its findings for all files encountered 
in the project.  

Spell Check 
The Project menu ‘Spell Check’ command launches the spelling checker for 
each section of the project.  It saves time by processing each file automatically.  
It uses the same familiar prompts as in the editor version.  

Execute 
If you run a command file of cleanup commands in the editor when finishing a 
section, consider running it here in the Project menu for all sections, 
automatically.  In this way you will not miss a section and will ensure that your 
specification is formatted consistently.  

Print All 
The ‘Print All’ command prints each section of the project, in order.  It is most 
often used after changing headers or doing a project replacement.  This 
command may take a while to complete (depending on how fast your printer is).  
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Window Menu 
NMS-Edit/Plus allows you to have up to 50 document windows open at once 
(assuming you have enough memory to hold them all).  You can switch 
windows by clicking the mouse on any part of a partially hidden window.  You 
may also change windows by pulling down the Windows menu and selecting the 
window by name. 

Each window is also given a number that represents it.  With the Window menu 
open, type the number to select that window. 

There are two other selections on this menu.  The first, ‘Tile’, shows all the 
windows tiled.  The second, ‘Cascade’, shows the windows overlapped. 
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Help Menu  

Contents  (F1) 
NMS-Edit/Plus uses the Windows Help Manager to provide you with on-line 
help in a familiar way.  (The Windows Help system is described in the Windows 
User Guide.)  

NMS List of Contents 
Choose this option to view the current NMS List of Contents as a Windows 
Help file.  NMS Divisions and Packages are broken down to show the individual 
sections, and each section contains a hypertext link to all related sections.  All 
general Spec Notes at the start of each section are shown as well.  

Statistics  (F12) 
When a section is open. The ‘Statistics’ command provides information about 
the section such as the file path, the date it was last modified, and the current 
page count (if calculated).  

 
Statistics Dialog Box 

About NMS-Edit/Plus 
This command displays the NMS-Edit/Plus version number and copyright 
notice.  It also shows the amount of free memory available for opening more 
windows. 

NMS-Edit/Plus is licensed for use on a single computer only.  Unless you have 
purchased a site license or multiple copies of NMS-Edit/Plus you should not 
have this software installed on more than one computer.  You may also NOT 
give away, loan or in any other way distribute a copy of NMS-Edit/Plus to any 
other person or company.  To do so is illegal and unethical. 
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About NMS-Edit/Plus 

Other Help Items 
As other spec-writing aids become available, they will appear in the Help Menu.  
For example, if you installed NMS-Edit/Plus from CD-ROM, you may have 
access to a help file of CGSB summaries of standards.  These aids are 
documents on spec-writing and related topics.  Having them on the Help menu 
gives you instant access to spec-writing information while you are working on 
your project. 

Mouse 
The mouse is used in NMS-Edit to position the cursor or to mark a block of text.  
When a block of text is already marked in the document, you can adjust the 
limits of the block by holding down the shift key on the keyboard and dragging 
with the left mouse button.  You can extend or contract either end of any block 
this way. 
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Keyboard 
There are also a number of special keyboard keys you should know about.  The 
keys that type special characters were described earlier on page 42.  This section 
describes some others used in editing.  

Ctrl-→ or Ctrl-←  moves the cursor one word to the right or left 

End    moves the cursor to the end of the line 

Home   moves the cursor to the beginning of the line 

Enter   moves the cursor to the beginning of the next 
    line 

 (The enter key does not insert or change anything in the document.  It only 
 moves the cursor.  If you need to insert new lines in the document use the 
 Newline command (F3)). 

Ctrl-Home   moves to the beginning of the document 

Ctrl-End   moves to the end of the document 

Insert    toggles between insert and overtype mode.  It 
    also changes the 'I' icon of the icon bar to  
    indicate which mode you are in. 
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Printer Controls 
NMS-Edit/Plus has a very intelligent printing capability.  For most 
specifications, simply printing with NMS-Edit/Plus will break the document into 
pages in a pleasing and easy-to-read manner.  Paragraphs will only be split 
across pages if two or more lines are on each page; headings will be continued 
(if appropriate) at the top of pages, etc.  The result will be a well laid-out 
specification. 

Sometimes there are special reasons for altering the layout of the specification 
beyond the normal constraints.  NMS-Edit/Plus provides for these by allowing a 
set of special lines to be inserted into the document at any point to tell it how to 
format the page.  These are entered into the document like normal lines of text.  
They must be typed at the left margin of the page.  They will not be printed in 
the final output. 

See the Insert command under the Edit menu for a convenient way to insert one 
of these printer controls into a document. 

Each of the control lines is described as follows. 

$PAGE [n] 
If you add a line to the document that begins with ‘$PAGE’ then a new page 
will be started at that point in the listing.  If the word $PAGE is followed by a 
number, then the break will occur only if less than that number of lines are left. 

For example: 
$PAGE 10 

starts a new page if less than 10 blank lines are left on the current page.  So, for 
example, to ensure that an entire table is kept on one page of the document, 
place the $PAGE on the line before the table, and number the $PAGE to the 
number of lines in the table. 

$SPACE [n] 
A line beginning with ‘$SPACE’ followed by a number will leave that many 
blank lines on the page.  If you have asked for more blank lines to be printed 
than are left on the page then a new page will be started but no blank lines will 
be placed at the top of the page. 

For example: 
$SPACE 3 

leaves three blank lines in the document. 
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$FOOT 
In most specifications the header at the top of the page contains the project 
name, the date, the page number and the company name.  When you look at a 
document on the screen, all of the lines up to the first blank line will be included 
in the header.  This header will be printed at the top of each page and the pages 
will be numbered appropriately.    

Some companies prefer to have their company name at the bottom of each page 
instead of at the top.  To do this in NMS-Edit/Plus you will need to add two 
lines to the document.  The first one must have ‘$FOOT’ at column 1.  The next 
line must contain the message to be printed at the bottom of each subsequent 
page of the document.  For example: 

$FOOT 
  Innovative Technology Inc. 

places our company name at the bottom of each page of the document on all 
subsequent pages. 

You can include the page number in the footer by including the word ‘page’ 
followed by a number.  The page number is placed in this location when the 
page is printed.  For example: 

$FOOT 
Innovative Technology Inc.   Page 1 

(NMS-Edit/Plus determines where the header ends and the text begins by 
finding the first blank line after the header.  The $FOOT control should never 
appear just after the header.  The best place to put it is separated from the header 
by one blank line.  That way, it will appear on every page but will not be 
considered part of the header.) 

$TABLE  
$END  

Sometimes NMS-Edit/Plus is not able to distinguish between a table and a 
paragraph.  This is especially true of free format text and tables with decimal 
numbers.  At other times your file is printed in such a way that the tables do not 
come out properly.  You may have extra blank lines or even be missing some 
lines.  If this should happen you can tell NMS-Edit/Plus to treat any area of a 
section as a table and to print it out exactly as it is in the file.  

You do this by placing a line with the word ‘$TABLE’ on it (at the left side) 
immediately before the area causing the trouble.  Then place another line after 
the problem area with the word ‘$END’ on it (also at the left side).  A table 
heading line should be placed after the $TABLE line. 

The $TABLE and $END lines form ‘brackets’ around that text.  Anything 
between these two lines will be printed exactly as it is.  NMS-Edit/Plus will 
make no attempt to adjust the spacing, accumulate continuation information or 
headings, or in any other way interpret the data. 
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For an interesting example of the use of tables, edit and print page one only of 
the file ‘title.doc’ from the NMS-Edit/Plus Samples directory. 

$COLS [col1] [col2] [col3] … 
When printing a section in a proportional font, text in a title or paragraph flows 
appropriately to fit the page width and font size.  But in a table with more than 
one column, the column margins may not form a smooth line but may appear as 
a ragged line.  To correct this problem, use the ‘$COLS’ command to specify 
the column positions.    

The parameters to $COLS are character column positions, taken from the 
column counter in the Icon Bar.  A column number may be prefixed with the 
letter ‘R’ to indicate a right-justified column.  A line with $COLS and no 
numbers resets a previous $COLS command.  Also, text aligned to the left 
margin needs no column position. 

Let’s take for example a List of Contents generated from the Project menu.  
Blanks are compressed to show the full line here. 

$COLS 9 R68 
Section Title                                Pages 
$TABLE  
 
$COLS  
Division 02 
$COLS 9 R71 
02220   Excavating and Backfilling               5 
02356   Pile Tests                               4 
$END 

The first $COLS sets a column to line up with text at column 9 (the word ‘Title’ 
on the next line), and sets the word ‘Pages’, starting at column 68, to right-
justify (to its rightmost character position, that is, to character 72). 

The next $COLS disables column justification for the division number. 

The last $COLS aligns the section titles which are at column 9 on the screen, 
and right-justifies the page count (allowing for a 2-digit number if required).  
The page count (plus leading spaces) is found at column 71 on the screen.  The 
section number needs no column number as it is at column 1 and left-justified. 

The $COLS command is not required for a fixed-space font such as Courier 
New, because text will always remain justified as it appears on the screen. 

$RESET [TABLES] 
In NMS format, paragraph and table headings are detected automatically and 
carried forward as long as required.  This means that the text on a page is always 
given a context.  There are times, however, when you would like to disable this 
feature.  The ‘$RESET’ command allows you to do this.   
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The command by itself will reset the continuation of all paragraphs and table 
headings until the next headings or paragraph titles are found. 

If the word TABLES is added to the line, only table headings are reset.  This is 
useful if you have two tables in a row with no intervening paragraph.  NMS-Edit 
will consider them to be one table and will only continue one set of headings 
unless the $RESET TABLES is added to the document between the tables. 
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NMS Updates 
The NMS is updated once a year, in January.  If you subscribe to the updates, 
we will send you a notice of the new version as soon as it is available.  After 
updating your NMS, you can get a printed copy of all the new sections by using 
the ‘Latest Update’ command from the Project menu in NMS-Edit/Plus.  This 
command followed by ‘Print All’ will produce the printed copy you need to 
update your binders.   
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